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CHAPTER 1. GENERALITIES 

The X3D graphic library is a set of high level graphic primitives: display functions of axes, 
legends, curves or surfaces, etc.  

• It allows the application programmer to produce two and three dimensional graphs with a 
system of axes and legends displayed automatically.   

• It allows the user to modify interactively the presentation of the graphs and to save this 
presentation in a style file for future use. 

 
 

1. GENERAL FUNCTIONALITIES 

1.1. Table display 

Several windows specific to X3D or belonging to applications using this library contain tables.  
For example, the graph editing window contains a table where each row is the definition of a 
graph used by the application.   
 
The format of these tables can be modified.  With the mouse, the columns can be moved or 
resized. 

• Move a column by placing the cursor of the mouse in the column header (the cursor takes 
the shape of a hand), clicking the left button of the mouse and moving the cursor to the 
desired location.  

• To resize a column, place the cursor on the right border of the column header (the cursor 
takes an arrow shape), click the left button and move the cursor until the desired width is 
achieved.  The width of the table columns is saved in the current database. 

Physically enlarging a column does not entail that it will contain values with more characters. 
 

1.2. Scrolling list associated to cells of a column in a table 

Scrolling lists are associated to cells of several columns in various tables. By placing the cursor 
on the right end of a cell, this cursor appears if a list is associated to the cell.  By activating the 
cell, a button is displayed at the right end of the cell.  Click on this button to display the scrolling 
list associated to the cell.  
 

1.3. Tooltip 

If the value of a text field, the header of a column or the value of a cell in a table is not 
completely visible, a tooltip shows the entire text when the cursor is placed over the text field, 
the header or the cell of the column. 
 

1.4. Accelerated scrolling of a list 

For several scrolling lists, it is possible to scroll directly close to the desired value, by entering 
the first characters of the value in the white cell.  
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1.5. Navigation in a table 

The vertical and horizontal scrolling bars can be used to scroll through the contents of a table. 
The [Enter] key is equivalent to clicking OK in the current window.  

 
When the cursor is in a cell, pressing [Home] or [End] brings the cursor to the beginning or end 
of the contents of the cell, respectively.  

 
To go from one cell to the next one on the right, press the [Tab] key.  When the cursor is at the 
end of a row, [Tab] brings the cursor to the first cell of the following row. To go from one cell to 
the previous one on the left, press [Shift]+[Tab].  When the cursor is at the beginning of a row, 
[Shift]+[Tab] brings the cursor to the last cell of the previous row.  
 
If the cursor is in a cell, the [Up Arrow] key brings the cursor to one cell above, in the same 
column; the [Down Arrow] key brings the cursor to one cell below, in the same column.   
 
Pressing [Page Up] or [Page Down] moves the cursor towards the top or bottom, in the same 
column, by the number of visible rows minus one, except if the top or bottom of the table is 
reached.  
 

1.6. Wheel of the mouse 

The wheel of the mouse can be used to scroll through all the X3D windows, data entry forms, 
lists of values and graphs.  
 

1.7. Saving the work environment in the registry 

When closing a module, the work environment is saved in the registry of the user’s workstation. 
The work environment, or the current usage parameters of the application, includes: 

• the names and directories of the last data files or database; 

• the names and directories of the last style, markers, patterns and logo files; 

• the characteristics of the current domain and its application status; 

• the default drawing attributes; etc. 
 
The information in the registry will be used when the application is launched again. The registry 
involved is shown in this tree structure: 
HKEY_CURRENT_USER 

➔ Software 
➔ SOBEK 

➔ Application (ex: LOG) 
➔ FormLastQuery 
➔ Geo 
➔ Import 
➔ X3D 
➔ ... 

 
1.7.1. Saving the work environment in HKEY_LOCAL_MACHINE 

In specific cases where a computer is used by several users (ex: computer rooms at 
universities), it may be useful to read the registry in the HKEY_LOCAL_MACHINE tree structure 
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(for the computer) instead of the HKEY_CURRENT_USER structure (for the user). To do this, 
define the parameter “HKEY” at the end of the Target in the properties of the Geotec module 
shortcuts. Geotec will read the values in HKEY_LOCAL_MACHINE, and then in 
HKEY_CURRENT_USER if they don’t exist in the first tree structure. 
 

PLEASE NOTE: We discourage using the registry editor to modify directly the values.  After an 
improper editing of any registry, the behaviour of the application is unpredictable. 

 
 

2. SPECIAL FONTS AND ATTRIBUTES 

It is possible to use special fonts and/or attributes in a chain of characters. The format can be 
used for any chain of characters in X3D (for example: an axis title, a graphic object, etc.). The 
format to use is: [text to modify]"font/biu+-" where: 

• b : bold + : superscript 

• i : italic - : subscript 

• u : underlined 
 

2.1. Use in a query 

To present the preconsolidation pressure with its symbol, the query (TESTS_E or an equivalent 
query) would contain the following bold part: 
… 
union select sample.site_no, sample.boring_no, sample.sample_no, 
depth as depth_top, depth+length as depth_bottom, 4 as rank,  
'[s]"symbol"’[p]"/-"' as result from sample inner join consolidation  
on (sample.sample_no = consolidation.sample_no) and (sample.boring_no = 
consolidation.boring_no) and (sample.site_no = consolidation.site_no) 
… 
 

The column showing the TESTS_E query then shows σ’p when a consolidation test is done on 

a sample.  
 

2.2. Use in objects 

To present only the boring number in bold letters, in the header of a boring log for example, the 
user can insert a text object and enter, in the Text field of its property window:  
 
BORING:    [&&BORING.BORING_NO ]"/bu" 
The object then shows    BORING:   BH-01 
 

2.3. Use in fields of the database 

It is also possible to use the format for any value in the database. For example, in the 
DESCRIPTION field of the STRATIGRAPHY table, the user could enter: 
 
[FILL]"/bi"|Gravel with pieces of concrete. 
 
The description then shows:  
FILL 
Gravel with pieces of concrete. 
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CHAPTER 2. FILE MENU 

The contents of the File menu in each application that uses X3D differs depending on the 
context.  The first format in Figure 2-1 is from the modules using only databases (Log, Lab, Pro, 
Time, Dam); the second is from Site, which also uses data files.   
 

  

Figure 2-1 - Examples of the File menu 
 
The File menu allows the user to:  

• open a .mdb database; 

• connect to a database; 

• create, retrieve, view and save data, in the Site module and the SM2 graphic library; 

• create, retrieve, view and save the graphic characteristics defined in a style file (.sty); 

• select and configure the printer and print the graphic outputs; 
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• retrieve a database or data file, a style file, markers or patterns file, a logo or a color file from 
the last 9 used. 
 

When opening a module, the last style file (.sty) used is loaded. If the file was deleted or 
moved, the standard window for file opening is displayed.  
 
When an application is first used, a default style file provided by Sobek is displayed. The 
Geotec8.mrk and Geotec8.ptn files are loaded, these files being installed in the 
C:\Geotec80\Style directory, where C: is the disk on which the application is installed. The user 
can choose other markers and patterns files.  
 
When exiting the application, the different parameters used are saved in the registry of the 
user’s workstation for future use.  
 
 

1. CONNECTION TO A DATABASE 

For modules using X3D, connecting to a database can be done in different ways: 

• Directly in the application shortcut; 

• Via the Connect Database option of the File menu. 
 
The Open Database option of the File menu or this button opens the standard window for file 
selection.  The extension proposed by default is .mdb, .accdb, .db3.  The directory proposed 
by default is the one where the last database used is located, or during the first use, the 
C:\Geotec80\Access directory. 
 
Each time the user selects a database via the Open Database option, the module creates the 
Geotec_Access and module_Access connection aliases in the administration environment of 
the ODBC data sources and associates the selected database to it.  When opening a module, if 
a connection alias is provided in the connection string, this alias is used to connect 
automatically to a database.  Geotec_Access will find the last database used by a Geotec 
module, while module_Access will connect to the last database used by the module.   
 

1.1. Call connection 

The connection to the database can be done directly when calling the application by entering 
the following string as target.  The string will be:  
C:\Geotec80\Bin\Module.exe username/password@odbc:connection_alias 
 
C:\Geotec80\Bin\Module.exe is the application call string. 

• C:\Geotec80\Bin\  where Geotec80\Bin is the directory where the application 
executable is located. This directory may have been modified during the installation by the 
computer technician.  

• Module.exe  where Module is the name of the executable, for example log. 
 
username/password@odbc:connection_alias is the connection string: 

• username/password username and password for the database used, for example 
geotec/sobek; 
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these elements are only with SQL Server and Oracle only, but must always be present for 
the connection string to be read correctly 

• @    separator introducing the database designation;  

• odbc: or oracle:  indicates if the database management system is connected via an 
ODBC driver, or if it is Oracle; 

• connection_alias  designates the source database as defined with the ODBC data 
source administrator or with Oracle, for example geotec_access. 
 

By adding the parameter “HKLM” at the end of the connection string, the module will read the 
parameters defined in the registry in the HKEY_LOCAL_MACHINE tree structure instead of the 
HKEY_CURRENT_USER structure. See paragraph 3.8.1 of chapter 1 of this guide. 
 

1.2. Connection via the File menu 

When retrieving data without being connected to a database, or when selecting the Connect 
Database option or this button, the connection window shown in figure 2-2 is displayed. 
 
This window shows the different parts of the connection string described in the previous 
paragraph. For an ODBC connection via this window, the username and password are not 
necessary.  

 

Figure 2-2 - Connection to a database via a module 
 
 

2. DATA FILES 

Data files can be used in the Site module and in the SM2 graphic library. 
 

2.1. Creating a new data file 

The New Data option allows the user to select a background file. The user can select in the 
scrolling list the different types of background files. A background file must be opened for the 
user to edit new cartographic data, which he can then save in a new file that will not contain the 
background. 
 
If the user selects the Cancel button in the background file opening window, Site or SM2 will 
return to the situation preceding the selection of the New Data option. The user cannot edit the 
information of a background file.  
 

2.2. Opening a data file 

To open a data file, select the Open Data option or click on this button in the application toolbar; 
this displays the standard window for file opening.  The user can select the desired type of files. 
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The user can browse to choose the desired data file.  The directory displayed initially is the one 
specified in the preferences. The user can also open a data file via Recent Data. 
 
If an AutoCAD .dxf file is selected, it is automatically converted to a .sit file. However, the .sit 
file is only saved if requested by the user via the data saving options of the File menu (see 
paragraph 2.3).  
 
If a data file is opened while modifications to the current data file have not been saved, a 
message is displayed to save or not the file.  
 

2.3. Saving a data file 

To save the modifications to the current data file, the user selects the Save Data option or this 
button, in the application toolbar. 
 
Select the Save Data As… option to save the data file under a different file name.  The default 
extension is the same as the extension of the current data file. 
 

2.4. Closing a data file 

To close the data file, click the option Close Data. If modifications were done on the current 
data file, a message is displayed asking to save or not the current file.  
 
 

3. STYLE FILES 

A style file contains all characteristics of a graphic presentation.  It is a reusable template. Each 
style file has characteristics specific to the application in which it was created. The application is 
responsible for the content of the style file; X3D manages the manipulations in the style file.  
 

3.1. Opening a style file 

To load a style file, select the Open Style option or click on this button; this displays the 
standard window for file opening where the file type to be retrieved is .sty.  The user can 
browse to choose the desired style file.  The directory displayed initially is the one containing the 
last style file used. The user can also open a style file via the Recent Styles option. 
 
If a style file is opened while modifications to the current style file have not been saved, the 
message shown in figure 2-3 is displayed. 
 
Each style file contains a part specific to the application for which it was created. If the user 
chooses a style file designed for an application other than the current one, a message is 
displayed and asks the user if he wants to select another style file: 

• if no, the application remains open with the current style file; 

• if yes, the standard window for file opening is displayed and the user can choose another 
style file created by the current application.  
 

If the file chosen as the style file to open is an ASCII file of .sty extension but not a style file, a 
message warns the user and the application stays in the current situation. If the file chosen is 
not an ASCII file, or is an ASCII file with an extension other than .sty, the behaviour of the 
application is unpredictable.   
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Figure 2-3 - Saving the modifications to the style file 
 
It is necessary to retrieve data to fill all the graphs and objects after changing the style file. 
 
The style files can be used with both English and French data dictionaries. The comparison is 
done automatically. 
 

3.2. Viewing a style file 

The View Style option is used to view the current style file in a text format that contains 
information about the format of the page and graphs, the titles and legends, the axes 
characteristics, the names of the graphic editing elements files, the markers and patterns used 
in the graphs, and other information related to the page. Figure 2-4 shows an example. 
 

 

Figure 2-4 - Viewing a style file 
 
The display attributes (font, size, text style) of the file viewed can be changed via the Font menu 
of the menu bar.  Its content cannot be modified, but can be printed.  
 
The user can also use other text editors to view the style files.  In the File tab of the preference 
editing window, select the executable of the text editor.  Then, when selecting View Style, the 
viewing will be done with the selected editor.  
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3.3. Saving a style file 

If modifications done on the current style file are not saved, the user will be asked to save when 
he tries to open another style file or to exit the module: click Yes to save the style file.  
 
The user can update the current style file by clicking the Save Style option or this button. Select 
the Save Style As… option to save the style file under a different file name.  The default 
extension is .sty. 
 
 

4. PRINTING 

4.1. Printer configuration 

The Printer Setup option is used to choose and configure the printer.  This option opens the 
standard window for printer setup and configuration.  
 
To obtain printings identical to what is shown on the screen, the option to print True Type fonts 
as graphs must be selected in the printer setup.  Other graphic options may also be required.  
These options vary from one printer to another.   
 
Printing is automatically done in “Landscape” if the height of the page is smaller than the width, 
and in “Portrait” otherwise.  
 

4.2. Printing a single graphic report 

A graphic report is a graphic result produced by the application, which is displayed on screen 
and can be printed on paper or in a file.  A graphic report is at least one page long.  It contains 
one or many graphs.  For example, a graphic report produced by Log is a boring log; this report 
has one to n pages and is made of several graphs: the various columns as well as the legend 
blocks.  Depending on the application, one or many graphic reports can be generated 
simultaneously.  For example, Log can generate as many boring logs as defined for a chosen 
site.    
 
Clicking on this button starts the printing of the current graphic report with the current printer. 
 
If the application only works with one graphic report or if only one of the graphic reports is 
active, selecting Print opens the window shown in figure 2-5 where the user can specify the 
range and destination for printing the current graphic report.  

• The Printer button opens the standard window for printer setup.  

• The radio buttons in the top area of the window define the printing range for the current 
graphic report: 

 All  Printing all pages 

 Odd  Printing odd pages 

 Even  Printing even pages 

 Current Printing the current page 

 Selection Printing a selection of pages defined in the text field according to the 
syntax shown as an example in the message zone of the window. 
 

If the current graphic report has only one page, only the All radio button is active.  
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Figure 2-5 - Printing graphic reports 

• If the box Print on file is not checked, printing will be done on paper with the current printer, 
including PDF creators.  Checking the box activates the radio buttons to choose the file type 
for the graphic report, instead of paper.  The WMF and DXF formats are read by AutoCAD, 
and the EMF format can be inserted in Microsoft Word (see paragraph 4.4 for details about 
the printing particularities of these files).  

• When printing on file, the user can prompt for filename. The file name by default is the 
concatenation of the primary keys (site and boring numbers, site and axis numbers, etc.). 

 

 

Figure 2-6 - Printing graphic reports in Pro 
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• When printing on file, a line width can be defined by selecting the check box and entering 
the width value in the field. It will be applied to all the lines in the graphic output. 

• When printing on DXF file in Pro (see Figure 2-6), each boring can be saved as a block. It 
is also possible to group all the blocks to facilitate the editing in AutoCAD. 

• When printing on DXF file in Pro, the user can also ask to number each block based on its 
axis and boring numbers. Otherwise, the nomenclature is based on a sequential number 
for the borings and an integer corresponding to the printing date, to have a unique number 
per block. 

 

4.3. Batch printing 

If several graphic reports are active, selecting the Print option displays a window as shown in 
figure 2-7. 

 
The context of the application determines the exact message and the wording of the buttons.  
Generally, a button is for printing all active graphic reports; while the other is for the current one 
only.  

 
When proceeding to printing (all or the current graphic report), the window shown in figure 2-5 to 
define the printing range and destination is opened.  

 

 

Figure 2-7 - Batch printing 
 
It is possible to select only some of the graphic reports to print, by unchecking the undesired 
records in the box opened by clicking on this button, located in the application toolbar.  

 
4.4. Printing particularities 

4.4.1. Printing dotted and dashed lines 

In order to print dotted and dashed lines as they appear on screen, the width of the « line » 
attribute must be 0 mm in the drawing attributes configuration window.  
 
4.4.2. Printing in normal mode 

• All texts defined on opaque background are drawn correctly.  The colors are interpreted in 
different tones of grey and the appearance on paper is quite different from what is seen on 
screen.  A pale color text on dark background does not show.  

• The fill zones do not appear as on screen.  

• The non-solid lines are always represented, whatever the line (straight or curve). 
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4.4.3. Printing in PostScript mode 

• All texts defined on opaque background are drawn correctly. The colors are interpreted in 
different tones of grey depending on the printer.  The appearance on paper is close to what 
is seen on screen.  A pale color text on dark background stands out well.  

• The non-solid lines are not represented with curved lines.  
 
4.4.4. EMF file 

• When a file is imported in Microsoft Word, the visual appearance is acceptable even though 
no color of opaque background for the texts is shown.  All the texts are shown as if there 
was a white opaque background, whether it is fixed by the application or not.  

• The fill zones do not appear as on screen.  

• The non-solid lines are not visible on screen with the curved lines. 

• When printing in normal mode: 

 The texts defined on opaque background are represented with no background. 

 The fill zones appear differently than on screen. 

 The non-solid lines are always represented as defined, even if they are not visible on 
screen with curved lines.  

• When printing in PostScript mode: 

 All texts are printed on white opaque background, whether it is defined by the application 
or not.  As on screen, all the color background defined by the application are ignored.  

 The fill zones appear as displayed on screen, which is different than the original 
converted in EMF format. 

 The non-solid lines are not represented with the curved lines. 
 

4.4.5. WMF file 

• This type of file can be used with: 

 Microsoft Word, but the results are not convincing! 

 AutoCAD; the resulting file is very similar to the original. 
The background filling of opaque texts is ignored, without other effects. 
The fill zones and the non-solid lines for curved lines are ignored. 
 

4.4.6. DXF file 

• All texts are shown without hiding what is under an opaque background.  However, all pale 
texts on dark background are respected, even if the background color (tone of grey) is not 
represented.  There is only one font style. 

• The fill zones are ignored.  

• The non-solid lines are respected only for straight lines (horizontal, vertical or inclined). 

• There is no difference of output between the PostScript and normal printing modes.  
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4.4.7. PDF file 

• The PDF format does not support texts on opaque background (the results are 
unpredictable, especially with inclined texts on opaque background). 

• The fill zones and all lines are respected on screen and when printing in PostScript and 
normal mode. 

 

4.5. Printing automatism for borehole logs 

It is possible to create scheduled tasks to print borehole logs with the Windows Task 
Scheduler tool. Two parameters are defined by the user for each task:  

• Type: The boring type to print (TYPE field of BORING table) 

• Days: The number of days since the last boring modification date (number of days between 
the current date and MODIFICATION_DATE of the BORING table) 

 
To create the automatism: 
1. Create a task (ex : Geotec CP, Geotec TF, etc.).  

2. Customize the trigger (weekly, monthly, time of trigger, etc.) 

3. Customize the action  

a. The program (example : C:\Geotec80\Bin\Log.exe ) 

b. The arguments include the connection alias for the database, the boring type and the 
number of days between the modification date and the current date. 

Geotec/gl@geotec_access type=tf days=7  

The query retrieves the borings with the correct type, and whose modification date is 
greater or equal to the current date minus the number of days. 

Example 1: With a current date of 2019-05-22 and 0 days, it includes the borings 
modified on 2019-05-22. 

Example 2: With a current date of 2019-05-22 and 7 days, it includes the borings 
modified on 2019-05-15 or more recently.  

 
The PRINTING_DATE is updated for each boring when it is printed (BORING table). 
 
The automatic printing is done on the default printer. It is important to define the parameters 
(ex : output directory for PDF files, paper size, etc.) 
 
The style file to associate to each boring type can be selected in the FILE_NAME field of the 
BORING_TYPE table (opened via the Types of borings button of the selection window). In the 
File tab of the Preferences in Log, by selecting “Save file name with path”, the complete 
location of the style file will be saved. If the option isn’t checked, only the file name will be 
saved, and it will be searched for in the directory of the current style file. In both cases, if the 
style file is not found, the current style file will be used for printing.  
 
A .txt report is generated every time a scheduled task is launched to indicate the number and 
list of printed borings. It is saved in the directory of output files defined in the preferences of Log 
on the workstation.  
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5. RECENT FILES 

Each Recent… option opens a submenu showing a list of the last 9 files used in the category 
corresponding to the option. The files are sorted in the reverse order of their opening order.  
Select a file to open it.   
 
 

6. CLOSING THE APPLICATION 

The Quit option of the File menu is used to quit the application.  Clicking on this button located 
in the application toolbar has the same role. 
 
When exiting an application, the utilization parameters are saved in the registry of the user’s 
workstation (see chapter 1).  The information in the registry will be used when the application is 
loaded again. 
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CHAPTER 3. EDIT MENU 

The Edit menu varies with the context.  An example is shown in figure 3-1. The Undo option is 
never active. The Cut, Copy, Paste and Delete options are the same as in all the Windows 
applications.  
 

 

Figure 3-1 - Edit Menu 
 
 

1. CALL FROM THE MAIN GRAPHIC WINDOW 

If the Edit menu is called while the active window is the main graphic window, no option in the 
menu will be available.  
 
 

2. CALL FROM AN EDITING WINDOW 

If the Edit menu is called while the current window is an editing window and the cursor is in a 
text field, the Paste option is available if a value has already been cut or copied, not necessarily 
in the same window.  The Cut, Copy and Delete options are available if a value is selected.   
 
It is also possible to use the shortcuts [Ctrl]+[X] (cut), [Ctrl]+[C] (copy), [Ctrl]+[V] (paste) and 
[Delete]. 
 
 

3. CALL DURING THE EDITING OF GRAPHIC OBJECTS 

When the application is in graphic editing mode and one or more objects are selected, the Cut, 
Copy and Delete options in the Edit menu as well as in the pop-up menu of the object are 
active.  If an object was cut or copied, the Paste option is also available. The shortcuts 
presented in the previous paragraph are also available.  
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CHAPTER 4. OBJECT MODE 

The graphic editing mode is opened via the Objects option of the Tools menu or this button 
located in the X3D toolbar.  The Object mode remains active until the user closes it by clicking 
again on Objects in the Tools menu or on this button which is located at the bottom of the 
graphic editing toolbar. 
 
The Insert menu groups graphic editing options.  The corresponding buttons are in the graphic 
editing toolbar. The menu and toolbar are shown in figure 4-1.  The options of the Insert menu 
allow the user to define and edit objects to be added to a graph or the current page.   
 

  

Figure 4-1 - Insert menu and graphic editing toolbar 
 

This allows the customizing of models with fixed elements such as logos, frames, labels, etc. 
These elements will be displayed every time the model is used, whatever the data presented.  
 
 

1. IMPORTING OBJECTS 

It is possible to import objects previously saved in an external .obj file (see next paragraph) by 
selecting the Import option or by clicking on this button in the graphic editing toolbar.  
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Selecting this option opens the standard window for file selection. The default directory is of the 
current style file.  The file type in this window is .obj.  Only .obj files can be read.  
 
The user can browse through the directories to find the object file.  When it is selected, click 
Open.  If objects are already associated to the style file in which to import, the application asks 
if the existing objects should be deleted before opening the selected .obj file.  
 
Each imported object will be associated to the graph with the same number as the graph to 
which the object was anchored when saved in the .obj file.  If no graph has this number, the 
imported object will be associated to the page (graph 0).  The imported object keeps its original 
size.  With respect to the new graph, the object will be placed in a position proportionally 
equivalent to the one it had with respect to the original graph.  It is therefore possible that the 
imported object be outside the limits of the page. In this case, reduce the display to see outside 
the page; the object can then be moved inside the limits of the page (see paragraph 3.6). 
 
 

2. EXPORTING OBJECTS 

It is possible to save objects in an external .obj file.  First, select the objects to be exported.  
Then, select the Export option or click on this button in the graphic editing toolbar.  
 
Selecting this option opens the standard window for file saving. The default directory is the one 
of the current style file, but the file can be saved in other directories.  The file must have the .obj 
extension to be read. 
 
Exporting objects stores the dimensions and drawing attributes of these objects, as well as the 
numbers of the graphs to which they are associated.  The position of each object with respect to 
its parent graph, expressed in proportion to the dimensions of this graph, is also exported.   
 
 

3. MODIFYING OBJECTS 

In graphic editing mode, when no option is selected, the cursor looks like and it is possible to 
select objects in order to move, modify or delete them. Clicking on the Selection option or on 
this button has the same effect.  
 

3.1. Single selection 

When the Selection mode is activated, click on an object to select it.  Handles are then 
displayed around the rectangle containing the objects. 
 
Even after selecting an object, the Selection mode remains active.  When an object is selected, 
click outside all objects in order to deselect it.  
 

3.2. Multiple selections 

Several methods exist to select more than one object at a time; however, the Selection mode 
must be activated.  
 
The user can select all objects inside a rectangular zone.  To do so, place the cursor at one 
corner of the zone, outside all objects, click and hold down the left button of the mouse, move 
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the cursor to the diagonally opposed corner of the desired zone, and release the button.  A 
dotted rectangle shows the movement of the cursor.   
 
Several objects can also be selected by holding down the [Ctrl] key while selecting them.  
 
It is also possible to display the pop-up menu using the right button of the mouse (see 
paragraph 3.3) and to click the Select all option to select all the objects added to the page and 
to its graphs.  The user can also press simultaneously the [Ctrl]+[A] keys to select all objects.  
 
If several objects are selected, it is possible to unselect one of them, by pressing the [Ctrl] key 
and clicking on the object.  To rapidly deselect all selected objects, open the pop-up menu with 
the right button and click on Unselect all.  
 
After multiple selections, handles may seem to be missing around some selected objects.  After 
deselections, some handles may remain displayed.  Click on this button to refresh the page in 
order for all the handles to appear or disappear, accordingly.  
 

3.3. Pop-up menu 

At all times, right clicking will open a pop-up menu of operations.  The number of options varies 
with the situation.  Figure 4-2 shows the pop-up menu displayed when one object is selected 
and the copy buffer is empty.  The Properties option is active if only one object is selected.  
 

3.4. Object properties 

Each object has a certain number of properties.  These can be modified via a window opened 
by double-clicking on the object or by selecting the Properties option of the object’s pop-up 
menu (see previous paragraph). 
 

 

Figure 4-2 - Pop-up menu of operations 
 
Depending on the object type, the number of properties and their availability varies slightly. 
However, these properties are always present: 

• The object type, which can never be modified 

• The number of the parent graph to which the object is associated, which can be modified 
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if no specific anchoring is defined (see paragraph 6), an object will be associated to the 
page (graph 0) when created 

• The position in X and Y of the anchor point of the object in the page; the global 
coordinates are expressed in millimeters, with respect to the origin of the page, i.e. the lower 
left corner 

• The position of the anchor point of an object expressed proportionally to the dimensions of 
the parent graph 

• The position in X and Y of the anchor point of the object expressed in the local 
coordinates of the parent graph 

to choose to express the position of the anchor point in global or local coordinates, check 
the box labelled Local mode 

when creating an object, the position of its anchor point is always expressed in global 
coordinates 

the coordinates of the anchor point, global or local, can always be modified unless the object 
is locked 

• By default, all objects are drawn over the graphs contained in the page.  It is possible to 
display an object behind the graphs by clicking the box labelled Background.  If the object 
is entirely or partly under a graph with a filling, the part of the object that is covered by this 
graph will not be visible 

This background option is different than the Foreground and Background options of the 
pop-up menu.  These options are used to modify the stacking of the objects with respect to 
each other (see paragraphs 17 and 18), not with respect to the graphs 

• To clip an object, check the box labelled Clip 

The clipping limits are the borders of the graph to which the object is associated. If an object 
is clipped, any part of the object outside the limits of its parent graph is not displayed 

• To lock an object, check the box labelled Lock 

• The four fields at the bottom left of the property window show the distances between the 
origin of the page to the sides of the rectangle framing the object, whether this object is 
anchored to the page or to a graph, and whether its coordinates are global or local; these 
values cannot always be modified 

 
Each property window is described with the object type.  
 

3.5. Locking objects 

Locking objects is used to fix their position with respect to the entity containing them. Locked 
objects cannot be moved.  However, it is possible to move the entity containing the locked 
objects, moving them at the same time.   
 
To lock objects, select them, open the pop-up menu and select the Lock option. It is also 
possible to select an object, open its property window and check the box labelled Lock. 
 
To unlock objects, select them, open the pop-up menu, and click the Unlock option. 
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3.6. Moving objects 

When objects are selected, if they are not locked, the cursor takes this shape  when in the 

zone containing the selected objects, indicating that they can be moved.  Hold down the left 
button of the mouse and move the cursor, which now looks like a hand , until the objects are 

at the desired location.  
 
Another possibility is to open the pop-up menu, to select Cut, to place the cursor where the 
upper left corner of the rectangle containing the selected objects will be, to open the pop-up 
menu again and to select Paste. The selected objects are then displayed in their new position.  
The user can also use the standard Cut and Paste buttons of the application toolbar, the Cut 
and Paste options of the Edit menu or the [Ctrl]+[X] and [Ctrl]+[V] shortcuts.  Finally, the 
position of the object’s anchor point can be modified in its property window.  
 

3.7. Copying objects 

To copy selected objects, hold down the left button of the mouse and the [Shift] key, and move 
the cursor, which now looks like a hand  until the objects are copied at the desired location. 

 
Another possibility is to open the pop-up menu, to select Copy, to place the cursor where the 
upper left corner of the rectangle containing the selected objects will be, to open the pop-up 
menu again and to select Paste.  A copy of the selected objects is then displayed at the new 
position.  The user can also use the standard Copy and Paste buttons of the application 
toolbar, the Copy and Paste options of the Edit menu or the [Ctrl]+[C] and [Ctrl]+[V] shortcuts. 
 

3.8. Resizing objects 

Except for texts, all objects can be resized.  Place the cursor on one of the handles around the 

object to resize.  The cursor will take one of these shapes    .  Click and hold down the 
left button of the mouse. Move the cursor to the desired dimensions and release the button.  
The selected object is then resized.  The user can also modify the object’s dimensions in its 
property window.   
 
This can be used to impose a distortion or to create a mirror effect, by moving a corner beyond 
the diagonally opposite corner. 
 
Modifying the shape of an adjustable object will automatically resize the rectangle containing the 
object.  
 
If a text zone is resized, it affects the rectangle containing the text and, consequently, the text 
wrap.  However, the font and text style are not affected.  
 

3.9. Erasing selected objects 

When objects are selected, it is possible to delete them by clicking [Delete] or by opening the 
pop-up menu and selecting the Clear option.  Paragraph 19 explains how to erase objects that 
are not selected.  
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4. SNAP GRID 

Select the Snap Grid option or click on this button to display the snap grid configuration window 
shown in figure 4-3.  The snap grid is practical to position graphs or objects in the page. 

 

 

Figure 4-3 - Snap grid configuration window 

• When the snap grid is active, the objects can only be moved on the magnetic points. 

• The spacing between the points of the grid can be identical, in X and Y.  The spacing is 
defined in X and Y, in millimeters. 

• The grid has four possible displays. It can be hidden, it can be shown with lines, or with 
crosses or squares at its nodes.  

• Next to the radio buttons, a button is used to open the drawing attributes window (see 
chapter 9) to modify the display of the snap grid.   

• The grid can be displayed in background. 

• The user can also define the dimension in pixels of the markers displayed at the nodes. 
 
 

5. DRAWING ATTRIBUTES OF OBJECTS 

The Drawing Attributes option of the Insert menu and this button located in the graphic editing 
toolbar are used to open the Attributes window.  The drawing attributes defined in the 
Attributes window will be used for the objects inserted afterwards.  
 

By clicking on the Default button of the Attributes window opened for a selected object, its 
attributes change to the default attributes defined in the preference editing window in the 
Default tab (see chapter 9). 

 
It is possible to modify the drawing attributes of an object by selecting it and opening its property 
window.  
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6. ANCHORING OBJECTS 

Anchoring objects is defined as associating objects to an entity, either the page or any graph 
defined in the page.  The objects are positioned relatively to the entity to which they are 
anchored.  If this entity is moved, its anchored objects also move.  If the entity is deleted, so are 
the objects.  By default, the objects are anchored to the page (graph 0). 
 
To define the entity to which the objects to be created will be anchored, select the Anchor 
Objects option or click on this button; the cursor takes this shape .  Then, click in the desired 

entity (a graph or the page); a symbol similar to this button will be displayed at the bottom left of 
the chosen entity.  
 

Tip: to choose the page as the anchoring entity while the page is covered with graphs, click 
outside the page, in any margin, or do not click on any graph.  

 
All newly created objects will be anchored to the chosen entity.  
 
To change the anchoring of already defined objects, choose the entity to which the objects 
should now be anchored, as described above.  Then, select the objects, open their pop-up 
menu and select Anchor. 
 
It is also possible to open the property window of the object whose anchoring must be changed 
and to enter the number of the entity (number of the parent graph) to which the object should 
now be anchored.  
 
Objects can be implemented outside the graphic page.  The user must realize that printing 
these objects is dependent on the sizing of the page. 
 
 

7. INSERTING A TEXT 

Select the Text option or click on this button to insert a text. The cursor takes this shape .   
Place the cursor where the anchor point of the text (lower left corner) will be located, and click.  
This opens the property window of a text, shown in figure 4-4. 
 
The object type, Text, is entered.  The location of the anchor point of the text can be modified 
and expressed in local coordinates. The parent graph to which the text is associated is 
indicated by its name and number. If an anchoring is not defined (see paragraph 6), the object 
being created is associated to the page (graph 0). The text can be clipped and locked. 
 
In the middle of the window, there is an input field for the text to display.  The entry can be done 
directly in this field, or in a text-editing window displayed by clicking on the  button.  The font 

in the editing window can be changed by clicking on the Font menu. There are a maximum of 
512 characters that can be displayed in each text. 
 
It is possible to insert the text of an ASCII file.  In the text editing window, select Open in the 
File menu and choose the desired file whose content is then displayed in the editing window.  
The default directory is the input files directory defined in the preferences.   
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A line feed is done with [Enter] in the text editing window, and with the “|” character in the entry 
field of the property window. 
 

 

Figure 4-4 - Properties of a text: Starting to insert 
 
The text entered can contain dynamic expressions such as the date, or a value from the 
database.  The dynamic expressions are associated to keywords whose syntax is $$word.  A 
list of general keywords including the date, time, name of the current style file, etc. is prepared 
by the X3D library.  The application completes this list with specific keywords.  This list is 
displayed by clicking on the arrow button associated to the $$ field.  The selection of a keyword 
adds it to the text entry field, preceded by $$.  Several dynamic expressions can be added in a 
text.  
 
When the application is connected to a database, it is possible to add to the text a value from 
the database. Select a table from the database via the list associated to the Table cell of the 
center table (the button to call the list is displayed when putting the cursor in the cell).  Similarly, 
choose a field from that table in the Field cell.  The lists show the tables and fields that exist in 
the connected database. The resulting keyword is entered in the entry field preceded by &&, as 
shown in figure 4-5.  Several keywords from the connected database can be added in a text.  
 
If the field belongs to a table that was already read by the application, its current value will be 
displayed for your information in the Value column.  If several values can be associated to the 
chosen field, the last value read is displayed.  If the selected field is empty or belongs to a table 
that has not been read by the application, the expression “n/d” is displayed for your information 
in the Value column; this expression will not be displayed in the resulting text, which remains 
empty.  The user must retrieve data to ensure that it is not due to a table not having been read. 
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Figure 4-5 - Properties of a text: Entering a value from the database 
 
If the && characters are replaced by @@, an expression equivalent to the value of the field 
designated by the keyword will be displayed, if this equivalence is defined in the 
EQUIVALENCE table. If the equivalence does not exist, the DESCRIPTION of the value in the 
LIST_ENG table (or LIST_FRE if the module is used in French) will be displayed. Otherwise, 
the value of the field is displayed. 
 
Example 1:  

The EQUIVALENCE table contains the following record:  BORING (table name), DIP (field 
name), 90 (value), Verticale (expression in French) and Vertical (expression in English). 
 
If an object is defined with the keyword @@BORING.DIP, and if, for the current boring, the 
value of the DIP field in the BORING table is 90, the expression Verticale or Vertical will be 
displayed, whether the module is used in French or in English.  If the DIP field of the 
BORING table contains 80 for the current boring, 80 will be displayed by the @@ 
BORING.DIP keyword. 
 

Example 2: 
The LIST_ENG table contains the following record:  BORING (table name), TYPE (field 
name), TR (value), Trench (description). 
 
The LIST_FRE table contains the following record: BORING (table name), TYPE (field 
name), TR (value), Tranchée d’exploration (description). 
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If an object is defined with the keyword @@BORING.TYPE, if for the current boring, the 
value of the TYPE field in the BORING table is TR, and if no equivalence is defined in the 
EQUIVALENCE table for this table, field and value, the expression Trench or Tranchée 
d’exploration will be displayed, whether the module is used in English or French. 

 
In the EQUIVALENCE table, if an expression is associated to the value: 

• “all” for a given field, this expression will be displayed, whatever the value of the field to be 
displayed via the @@table.field keyword.   

• “null” for a given field, this expression will be displayed if the field to be displayed via the 
@@table.field keyword contains no value. 

 
Each keyword added to the text via the $$word list or via the lists of tables and fields in the 
central table is placed at the end of the text.  It can be moved using “cut-paste”. 
 
If a keyword is a number or a date, the user can define its format right after the keyword. 

• The numeric format is of type "9.999". This example indicates that the value will have three 
decimals. 

• The supported date and time formats are: 
yyyy-mm-ddThh:mi:ss 2012-10-16T13:19:53  (ISO format) 
yyyy-mm-dd hh:mi:ss 2012-10-16 13:19:53 
yyyy-mm-dd  2012-10-16 
yy-mm-dd  12-10-16 
yyyy-mm   2012-10 
mm-dd   10-16 
jj m2 yyyy  16 10 2012 
jj month yyyy  16 October 2012 
jj m3 yyyy  16 Oct 2012 

 
The formats can be written in capital or lowercase.  The “y” (year) can be replaced by “a” 
(année), the “d” (day) by “j” (jour), the word “month” by “mois”.  Any character, except “a”, 
“y”, “m”, “j”, “d”, “h”, “s” can be used as separator.  All parts of the date format can be 
inverted.  

 
Click OK to complete the text entry. By default, the text is aligned on the lower left corner, 
unless another alignment was previously defined via the Drawing Attributes option of the 
Insert menu or after selecting an existing object.  
 
If the property window of the text is re-opened, the positions of the key points around the text 
are displayed at the bottom right of the property window, as shown in figure 4-6.  The fields 
defining the rectangle framing the text are not modifiable.  
 
The drawing attributes of the text can be modified by clicking on the Attributes button in the 
property window.  Chapter 9 of this guide gives more information about the configuration of the 
drawing attributes.  
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Figure 4-6 - Properties of a text completely defined 
 
 

8. INSERTING A TEXT ZONE 

Select the Text Zone option or click on this button to insert a text zone: an object consisting of a 

rectangle containing a text. The cursor takes the following shape .  Place the cursor where 
one of the corners of the text zone should be located, and hold down the left button.  Move the 
cursor until the dotted rectangle following its movement has the appropriate dimensions for the 
text zone, and release the button.  This opens the property window for a text zone as shown in 
figure 4-7. 
 
The object type, Text Zone, is entered.  The number of the parent graph to which the text zone 
is associated and the location of its anchor point, defined in global or local coordinates, can 
be modified. The text zone can be clipped and locked. 
 
Inputting text is done the same way as for text objects, either directly in the Text field or via the 
text editing window opened by clicking on the  button (see previous paragraph).  It is possible 

to insert the text of an ASCII file.  It is also possible to insert $$word, &&table.field or 
@@table.field keywords (see previous paragraph).  
 
The text string is automatically cut (“Word Wrap”) to fit in the rectangle defined.  The text is 
adjusted when the dimensions of the rectangle change.  If the rectangle is too small, the text will 
go beyond the rectangle’s borders.  
 
The drawing attributes of the text zone can be modified, including the border and the 
background of the rectangle forming the zone, via the window opened by clicking on the 
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Attributes button.  The alignment button in the drawing attributes window sets the position of 
the text’s anchor point in the rectangle.  By default, the text is aligned on the upper left corner.  
 
The text zone can have rounded corners.  The two fields at the bottom right are used to define 
the corner shape.  The rounding value cannot exceed half the length of the side to which it 
applies.   
 
The dimensions of the rectangle can be adjusted using the four fields at the bottom left of the 
property window. The rectangle can also be resized as described in paragraph 3.8. 
 

 

Figure 4-7 - Properties of a text zone 
 
 

9. INSERTING AN IMAGE 

Select the Image option or click on this button to insert an image stored in an image file.  

The cursor takes the following shape .  Place the cursor where one of the corners of the zone 
containing the image should be located, and hold down the left button.  Move the cursor until the 
dotted rectangle following its movement has the appropriate dimensions for the zone, and 
release the button.  This opens the property window as shown in figure 4-8, where the object 
type is Image. 
 
In the File field, the user can enter directly the name of the image file to display.  If the file is not 
preceded by the access path, the application will search for the file in the input files directory 
defined in the preferences. If the file is not found, the object will contain the file name preceded 

by the input files directory.  The user can also select a file by clicking on the  button, which 
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opens the standard window for file selection.  The directory is of the input files.  The user can 
browse to find a file in another directory.  When the file is selected, click Open.  
 

 

Figure 4-8 - Properties of an image 
 
The file type proposed by default is “Image Files”, which groups the types mentioned below.   
The user can restrict the list to a certain category by changing the type via the scrolling list.  

• Bitmap Files (*.bmp); 

• GIF Files (*.gif); 

• Jpeg Files (*.jpg, *jpeg, *.jfif); 

• PCX Files (*.pcx); 

• PNG Files (*.png); 

• TGA Files (*.tga); 

• TIF Files (*.tif, *.tiff). 
 

If the application is connected to a database, the user can indicate in File a field name where a 
file name can be found, possibly with its access path, with the format &&table.field (example: 
&&boring.photo_no). The field can be selected via the central table and its scrolling lists 
associated to the cells.  
 
By default, the size of the image is adjusted to fill the maximum of the rectangle area while 
keeping the original proportions; the box Keep image proportion is checked.  The image is 
displayed at the top or left of the object.  Even if the image does not fill the entire area of the 
rectangle, the object containing the image keeps the dimensions of the rectangle, as shown in 
figure 4-9 (a yellow background was defined for the object to show the area filled by the image 
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in the object).  If the box Keep image proportion is not checked, the image will fill the entire 
rectangle area but will be deformed with respect to the original. 
 

 

Figure 4-9 - Object containing an image 
 
The presentation and content of the object can be modified in its property window.  The number 
of the parent graph to which the image is associated and the location of its anchor point, defined 
in global or local coordinates, can be modified. The image can be clipped and locked. 
 
If a value is entered in the field Margin (mm), the image will be reduced to leave the width of 
the margin around the image, as shown in figure 4-10. 
 

 

Figure 4-10 - Object containing an image with margin and no frame adjustment 
 
If the box Adjust frame to image is checked: 

• If there is no margin and drawing attributes are defined for the line, a frame is drawn to the 
size of the image.  In this case, the frame is visible only if the line is thick; otherwise, it is 
covered by the image. 

• If a margin exists and drawing attributes are defined for the line, a rectangle is drawn, and 
the distance between its sides and the sides of the image is equal to the margin.  

The position of the rectangle in the object depends on the alignment set in the drawing 
attributes window for the object.  The background defined in this window only fills the 
adjusted rectangle, as shown in figure 4-11. 

 

 

Figure 4-11 - Object containing an image with margin and frame adjustment 
 
If the box labelled Use as logo is checked, the expression $$logo replaces the chosen file 
name in the File field, and the file becomes the current logo file in the File tab of the preference 
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editing window (see chapter 6).  If the File field contains the expression $$logo, clicking on the 

 button will open the standard window for file selection at the directory of the current logo file. 
 
The content of the file can be inclined in the object, by entering the value in the field Image 
angle.  
  
The dimensions of the object can be adjusted using the four fields at the bottom left of the 
property window. The object can also be resized as described in paragraph 3.8. The dimensions 
of the image in the object are adjusted consequently.  
 
 

10. INSERTING A RECTANGLE 

Select the Rectangle option or click on this button to insert a rectangle. The cursor takes the 

following shape .  Place the cursor where one of the corners of the rectangle should be 
located, and hold down the left button.  Move the cursor until the dotted rectangle following its 
movement has the appropriate dimensions, and release the button.  The rectangle is displayed 
with the current drawing attributes. 
 

 

Figure 4-12 - Properties of a rectangle 
 
The presentation of the rectangle can be modified in its property window, as shown in figure 
4-12.   The object type, Rectangle, is entered. The number of the parent graph to which the 
rectangle is associated and the location of its anchor point, defined in global or local 
coordinates, can be modified. The rectangle can be clipped and locked. 
 
The drawing attributes of the rectangle can be modified, including the border (line), the 
background (filling) and the pattern, via the window opened by clicking on the Attributes button.    
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The rectangle can have rounded corners.  The two fields at the bottom right are used to define 
the corner shape.  The rounding value cannot exceed half the length of the side to which it 
applies.   
 
The dimensions of the rectangle can be adjusted using the four fields at the bottom left of the 
property window. The rectangle can also be resized as described in paragraph 3.8. 
 
 

11. INSERTING AN ELLIPSE 

Select the Ellipse option or click on this button to insert an ellipse. The cursor takes the 

following shape .  Place the cursor where one of the corners of the rectangle containing the 
ellipse should be located, and hold down the left button.  Move the cursor until the dotted ellipse 
following its movement has the appropriate dimensions, and release the button.  The ellipse is 
displayed with the current drawing attributes. 
 
The presentation of the ellipse can be modified in its property window, as shown in figure 4-13. 
The object type, Ellipse, is entered. The number of the parent graph to which the ellipse is 
associated and the location of its anchor point, defined in global or local coordinates, can be 
modified. The ellipse can be clipped and locked. 
 
The drawing attributes of the ellipse can be modified, including the border (line), the background 
(filling) and the pattern, via the window opened by clicking on the Attributes button.    
 
The dimensions of the rectangle containing the ellipse can be adjusted using the four fields at 
the bottom left of the property window. The rectangle containing the ellipse can also be resized 
as described in paragraph 3.8. 
 

 

Figure 4-13 - Properties of an ellipse 
 
 



 Object Mode 4-17 
 
 

Inserting a pie 2019-09-26 
 

 

12. INSERTING A PIE 

Select the Pie option or click on this button to insert a pie chart.  The cursor takes the following 

shape .  Place the cursor where the center of the ellipse containing the pie should be located, 
and hold down the left button.  Move the cursor until the dotted line following its movement has 
the appropriate dimensions, and release the button.  The pie is displayed with the current 
drawing attributes. When created, a pie is always the quarter of a circle or ellipse.  
 
The presentation of the pie can be modified in its property window, as shown in figure 4-14. The 
object type, Pie, is entered.  The number of the parent graph to which the pie is associated and 
the location of its anchor point, defined in global or local coordinates, can be modified. The 
pie can be clipped and locked. 
 
The drawing attributes of the pie can be modified, including the border (line), the background 
(filling) and the pattern, via the window opened by clicking on the Attributes button.    
 
The dimensions of the rectangle containing the pie (part of an ellipse) can be adjusted using the 
four fields at the bottom left of the property window. The rectangle containing the pie can also 
be resized as described in paragraph 3.8. 
 
The table at the bottom right of the property window shows the coordinates of the three points 
defining the pie.  These fields, except the coordinates of point 1 which is the center of the 
ellipse, can be modified. The shape of the pie can therefore be altered; however, this is easier 
to do with the mouse.  
 

 

Figure 4-14 - Properties of a pie 
 
To adjust the shape of the pie, select it and bring the cursor on one of the two “summits” of the 

pie.  The cursor takes the shape .  Click and hold down the left button; the cursor takes the 

shape .  Move the point to the desired position and release the button.  
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13. INSERTING AN ARC 

Select the Arc option or click on this button to insert an arc. The cursor takes the following 

shape .  To insert an arc, click and hold down the left button of the mouse.  Move the cursor 
until the dotted line following its movement has the appropriate dimensions, and release the 
button.  The arc is then displayed with the current drawing attributes. When created, an arc is 
always the quarter of a circle or ellipse.  
 
The presentation of the arc can be modified in its property window, as shown in figure 4-15. The 
object type, Arc, is entered.  The number of the parent graph to which the arc is associated 
and the location of its anchor point, defined in global or local coordinates, can be modified. 
The arc can be clipped and locked. 
 
The drawing attributes of the arc can be modified, i.e. the border (line), via the window opened 
by clicking on the Attributes button.    
 
The dimensions of the rectangle containing the arc (part of an ellipse) can be adjusted using the 
four fields at the bottom left of the property window. The rectangle containing the arc can also 
be resized as described in paragraph 3.8. 
 
The table at the bottom right of the property window shows the coordinates of the three points 
defining the arc.  These fields, except the coordinates of point 1 which is the center of the 
ellipse, can be modified. The shape of the arc can therefore be altered; however, this is easier 
to do with the mouse.  
 

 

Figure 4-15 - Properties of an arc 
 
To adjust the shape of the arc, select it and bring the cursor on one of its two ends.  The cursor 

takes the shape .  Click and hold down the left button; the cursor takes the shape .  Move 

the point to the desired position and release the button.  
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14. INSERTING A LINE 

Select the Line option or click on this button to insert a line. The cursor takes the following 

shape .  To insert a line, place the cursor where one end of the line will be.  Click and hold 

down the left button of the mouse.  Move the cursor until the dotted line following its movement 
has the appropriate dimensions, and release the button.  The line is then displayed with the 
current drawing attributes. To obtain a horizontal or vertical line, hold down the [Shift] key while 
defining the line.  
 
The presentation of the line can be modified in its property window, as shown in figure 4-16. The 
object type, Line, is entered.  The number of the parent graph to which the line is associated 
and the location of its anchor point, defined in global or local coordinates, can be modified. 
The line can be clipped and locked. 
 
The drawing attributes of the line can be modified, including the border (line) and the marker for 
its ends, via the window opened by clicking on the Attributes button.    
 
The table at the bottom right of the property window shows the coordinates of the points 
defining the line.  These fields can be modified.  The dimensions of the rectangle containing the 
line are shown at the bottom left.  

 

Figure 4-16 - Properties of a line 
 
It is easier to adjust the shape of the line with the mouse.  Select the line and bring the cursor 

on the point to be moved.  The cursor takes the shape .  Click and hold down the left button; 

the cursor takes the shape .  Move the point to the desired position and release the button.  
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15. INSERTING A POLYLINE 

Select the Polyline option or click on this button to insert a polyline.  The cursor takes the 

following shape .  To insert a polyline, all of its points must be defined with a 

click.  To obtain a horizontal or vertical segment, hold down the [Shift] key 
between two points.  When the last point of the polyline is defined, right click to 
display the pop-up menu shown here and select Terminate to finish inserting 
the polyline.  
 
The presentation of the polyline can be modified in its property window, as shown in figure 4-17. 
The object type, Polyline, is entered. The number of the parent graph to which the polyline is 
associated and the location of its anchor point, defined in global or local coordinates, can be 
modified. The polyline can be clipped and locked. 
 
The drawing attributes of the polyline can be modified, including the border (line) and the marker 
for its summits, via the window opened by clicking on the Attributes button.    
 
The table at the bottom right of the property window shows the coordinates of the points 
defining the polyline.  These fields can be modified.  The dimensions of the rectangle containing 
the polyline, shown at the bottom left, are automatically modified and cannot be edited. 
 

 

Figure 4-17 - Properties of a polyline 
 
When a polyline has been completely defined, it is possible to modify its shape by editing the 
coordinates of its points but it is easier to do so with the mouse.  To move one point of the 

polyline, select the polyline and bring the cursor on the point.  The cursor takes the shape .  

Click and hold down the left button; the cursor takes the shape .  Move the point to the 

desired position and release the button. 
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When the polyline is selected, it is also possible to delete or add a point.  To 
delete a point, place the cursor on the point, and right click to display the pop-up 
menu shown here; and select Delete a point.  To add a point, place the cursor 
on the point that will follow the new point, and right click to display the pop-up 
menu. Select Add a point and move the cursor to the position for the new point. 
Left click to finish the addition.   
 
If a polyline has only one point, the marker defined (or a little circle if no marker was defined) will 
be displayed at this point.   Finally, the rectangle containing the polyline can be resized as 
described in paragraph 3.8. 
 
 

16. INSERTING A POLYGON 

Select the Polygon option or click on this button to insert a polygon.  The cursor takes the 

following shape .  To insert a polygon, all of its points must be defined with 

a click.  To obtain a horizontal or vertical segment, hold down the [Shift] key 
between two points.  When the last point of the polygon is defined, right click 
to display the pop-up menu shown here and select Terminate to finish 
inserting the polygon.  
 
The presentation of the polygon can be modified in its property window, as shown in figure 4-18. 
The object type, Polygon, is entered. The number of the parent graph to which the polygon is 
associated and the location of its anchor point, defined in global or local coordinates, can be 
modified. The polygon can be clipped and locked. 
 

 

Figure 4-18 - Properties of a polygon 
 
The drawing attributes of the polygon can be modified, including the border (line), the 
background (filling) and the pattern, via the window opened by clicking on the Attributes button.    
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The table at the bottom right of the property window shows the coordinates of the points 
defining the polygon.  These fields can be modified.  The dimensions of the rectangle containing 
the polygon, shown at the bottom left, are automatically modified and cannot be edited. 
 
When a polygon has been completely defined, it is possible to modify its shape by editing the 
coordinates of its points but it is easier to do so with the mouse.  To move one point of the 

polygon, select it and bring the cursor on the point.  The cursor takes the shape .  Click and 

hold down the left button; the cursor takes the shape .  Move the point to the desired position 

and release the button. 
 
When the polygon is selected, it is also possible to delete or add a point.  
To delete a point, place the cursor on the point, and right click to display 
the pop-up menu shown here; and select Delete a point. To add a point, 
place the cursor on the point that will follow the new point, and right click to 
display the pop-up menu. Select Add a point and move the cursor to the position for the new 
point. Left click to finish the addition.   
 
A polygon must have at least 3 points to be defined.  Finally, the rectangle containing the 
polygon can be resized as described in paragraph 3.8. 
 
 

17. MOVE TO FOREGROUND 

As objects are inserted, the last objects added can cover previous ones. To move an object to 
the foreground, select the Foreground option or click on this button.   
 
The cursor takes the shape . Place the cross of the cursor in the object to move to the 

foreground and click.  
 
Please note: The “foreground” mode stays active until another option is selected.  
 
 

18. MOVE TO BACKGROUND 

As objects are inserted, the last objects added can cover previous ones. To move an object to 
the background, select the option Background option or click on this button.   
 
The cursor takes the shape . Place the cross of the cursor in the object to move to the 

background and click. 
 
Please note: The “background” mode stays active until another option is selected.  
 
This background option is only for the objects with respect to one another.  It cannot be used to 
place an object in the background of the graphs in the page.  To do so, click on the 
Background box in the object’s property window (see paragraph 3.4).  
 
 



 Object Mode 4-23 
 
 

Erasing non-selected objects 2019-09-26 
 

 

19. ERASING NON-SELECTED OBJECTS 

Paragraph 3.9 explains how to erase selected objects.  It is possible to erase non-selected 
objects.  Select the Erase option in the Insert menu or click on this button.  The cursor takes 

the shape . Place the cursor in the object to erase and left click.  

 
Please note: The “erase” mode stays active until another option is selected.  
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CHAPTER 5. VIEW MENU 

The options of the View menu are used to change the display characteristics of the graphs in 
the current page.  The buttons corresponding to the options of the View menu are in the top part 
of the X3D toolbar located on the left side of the screen in each application.  The menu and 
toolbar are illustrated in figure 5-1.  Based on the application, some options of the View menu 
are not appropriate and are either inactive or hidden.   
 

   

Figure 5-1 - View menu and top of the X3D toolbar (Site module) 
 
 

1. REFRESH 

The Refresh option (the first in the View menu), or this button in the application toolbar, is used 
to regenerate all graphs contained in the page in their current limits.  
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2. ZOOMING ON THE PAGE 

The 2nd and 3rd groups of options in the View menu, between Full Page and Other, are options 
to zoom on the whole graphic page; in other words, these options provide “hardware” zooms.  
The options provide a blow-up or reduction of the contents of the window showing the graphic 
page.  These options are active in all applications.  
 
No zoom creates a distortion of the page, which always maintains the same width/height 
proportion. 
 

2.1. Full Page and Full Width 

The selection of the Full Page option or the opposite button adjusts the display of the graphic 
page to be displayed entirely in the window.  
 
The selection of the Full Width option or the opposite button adjusts the display of the graphic 
page to the full width of the window containing it.  If the height of a page is greater than its width, 
the vertical scrolling bar is available. 
 

2.2. 50%, 100% and 200% 

Selecting the 50%, 100% and 200% options fixes the magnification percentage of the graphic 
page to the value corresponding to the selection.  At 100%, the graphic page is very similar to 
how it would appear once printed on 8 ½ by 11 inches format.  
 

2.3. Other 

Selecting Other lets the users define a magnification percentage for the graphic page. The 
button on the left has the same role.   
 
 

3. ZOOMING ON THE GRAPHS 

The 5th and 6th groups of options in the View menu, between Rectangle and Reset All, are 
options to zoom in particular graphs in the graphic page; in other words, these options provide 
“software” zooms.  The options are used to expand or reduce the display of the graph. They are 
not active in all the applications.  
 

3.1. Rectangle, Factor, Pan 

When one of these three options is selected, only the View and Window menus remain active.  
Once the zoom is done, the button is deselected or the Refresh option is clicked, the menus 
become active again.   
 
Select the Rectangle option or the opposite button to define the portion of the graph to enlarge.  
Hold down the left button of the mouse, and move the cursor to obtain the rectangle that will be 
zoomed in on.  This rectangle must be completely contained in a graph. For the graphs with 
an imposed distortion, the dimensions of the selection rectangle are adjusted in order for the 
enlargement to be contained in the same frame as the original display.  For the graphs without 
an imposed distortion, the zoom is done on the selection rectangle delimited by the user.  A 
distortion is then created.  In all cases, the limits of the axes are modified automatically to reflect 
the change of display of the graph.  
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The Factor... option or the opposite button is used to specify the transformation ratio of a graph.  
A factor of 2.0 doubles the scale.  A factor of 0.5 reduces the scale by half.  After selecting this 

option, the cursor appears as .  Click on the point of the graph around which the 
transformation will be done, and enter the transformation factor in the dialog box.  The result of 
this transformation is in a frame of same size as the original display.  
 
The Pan option or the opposite button is used to shift the contents of a graph.  After selecting 

this option, the cursor appears as .  Click on the point of the graph to move, and hold down 
the left button of the mouse.  Move the point to the desired location in the graph.  A dotted line 
shows the shift that will be done.  Release the button and the contents of the graph will be 
shifted.   
 
The Rectangle, Factor and Pan options can be deselected by clicking again on the 
corresponding button or by refreshing the page.  
 

3.2. Previous, Initial, Reset All 

The Previous option acts as a toggle.  Selecting it or clicking on the opposite button restores 
the limits of the current graph as they were before the last change.  By selecting Previous 
again, the limits are brought back to how they were after the last change.   
 
The Initial option is used to restore the coordinates of the current graph as they were when the 
page was opened.  
 
The Previous and Initial options have an effect on the current graph.  The current graph is the 
last one in which the user did an operation or clicked.   
 
The Reset All option or the opposite button applies to all graphs of the page; the limits are 
brought back to their initial values.  
 
 

4. CONTINUOUS ZOOM 

The 4th group of the View menu has the option Continuous Zoom, with its equivalent button 
shown on the left, which is used to do “hardware”, “software”, pan and 3D zooms. When the 

option is selected, the cursor looks like . The page stays in “continuous zoom” mode and the 
option in the View menu is checked until the mode is deselected.  The possible actions in 
“continuous zoom” mode are also available in normal mode if the [Alt] key is pressed and held 
down.  
 

4.1. “Hardware” zoom 

In “continuous zoom” mode, a “hardware” zoom is done with the left button of the mouse.  
Hold down the left button of the mouse and move towards the top to increase the size of the 
window in the screen, or towards the bottom to reduce the size.  If the application is in normal 
mode, pressing [Alt] and the left button is equivalent. This option works in all applications. 
 
A “hardware” zoom can also be done the same way but with the right button of the mouse by 
clicking outside all graphs.  
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Finally, a “hardware” zoom can be done with the wheel of the mouse.  By clicking outside all 
graphs, move the wheel towards the top or bottom to increase or reduce the size of the window 
on the screen, and refresh the page with this button, the Refresh option of the View menu, or 
the [F5] key.  
 

4.2.  “Software” zoom 

A “software” zoom is done with the right button of the mouse.  Place the cursor in the graph 
whose display is to be changed (and the axes limits).  Click and hold down the right button, and 
bring the cursor towards the top of the screen to increase the scale, or towards the bottom to 
reduce the scale.  If the application is in normal mode, pressing [Alt] and the right button in the 
desired graph is equivalent.   
 
A “software” zoom can also be done with the wheel of the mouse.  Click in the desired graph, 
scroll the wheel towards the top or bottom to increase or reduce the scale and refresh the page 
with this button, the Refresh option of the View menu, or the [F5] key. During the process, a 
dotted line shows the increasing or reducing factor of the graph.   
 
This “software” zoom is not active in all the applications. 
 

4.3. Pan zoom 

It is possible to move the contents of a graph with the wheel of the mouse.  Click and hold down 
the wheel on the point of the graph to move.  In the frame of the graph, drag the selected point 
to the location it must have after the move, and release the wheel.  If the application is in normal 
mode, pressing [Alt] and the wheel is equivalent. 
 
By doing the same steps but after clicking outside all graphs, the entire graphic page is moved 
in the window, if horizontal and/or vertical scrolling bars are present. 
 

4.4. 3D zoom 

When a PLAN_VIEW is in 3D by selecting the 3D View option in the View menu or the opposite 
button located in the application toolbar (Site and Dam modules) or when the 3D_VIEW is 
dispayed (Pro module), it is possible to change its view point by placing the cursor in the 3D 
graph and clicking the left button of the mouse (in continuous mode).  Hold down the left button 
and move the graph until the desired view point is achieved.  If the application is in normal 
mode, pressing [Alt] and the left button is equivalent. 
 
A “software” zoom can also be done in 3D graphs, the same way as described in paragraph 
4.2. 
 
 

5. OPENGL 

The PLAN_VIEW in Site and Dam can be displayed in OpenGL mode (instead of normal XVT 
mode).  For this, select the option OpenGL Mode of the View menu or the opposite button 
located in the application toolbar.  
 
The OpenGL mode is used to view solids and surfaces with hidden lines and faces and 
shadows in 3D. The XVT mode is the standard display mode. See the Site guide. 
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CHAPTER 6. TOOLS MENU 

The options of the Tools menu are used to define the usage settings for the application and to 
edit the graphic components produced by the application: the characteristics of the graphic 
page, of the graphs, legends, axes, markers and patterns used. The buttons corresponding to 
the options of the Tools menu are in the bottom part of the X3D toolbar located on the left side 
of the screen in each application.  The menu and toolbar are illustrated in figure 6-1. 
 

  

Figure 6-1 - Tools menu and bottom of the X3D toolbar 
 
The main types of components for an X3D graph are: 

• There is only one page per window.   

• The graphs are associated to the page.  

• The objects are associated to the page or the graphs.  

• The data are represented in graphs as curves with or without markers, as histograms with 
or without patterns, as text, etc.  

• The system of axes and the legend are associated to a graph and the data.  
  
 

1. LANGUAGE SELECTION 

Selecting the Language option opens a submenu where the user can select English or French 
as the utilisation language of the module.  All the labels in the windows and the various 
messages sent by X3D and the application will be in the language selected.  The language of 
the lists of values will be automatically modified. The language can also be changed in the 
General tab of the preference editing window (see paragraph 6.1.1). 
 
When exiting the application, the current language is saved in the registry of the user’s 
workstation for the application. At the next utilisation, the application will be in the last language 
used. 
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2. PAGE 

Select the Page option or click this button to open the page editing window shown in figure 6-2. 
This window is used to configure the current page, i.e. the one in the foreground which contains 
all the graphs.  
 
In the page editing window, the user can change the dimensions and the display portion of the 
page, on the screen or the printer. 
 

2.1. Dimensions of the page 

The fields in the Page dimensions (mm) section are used to define the dimensions of the 
page, in millimeters. 
 
The scrolling list associated to the Standard field is used to select a predefined format, such as 
“letter”, “legal”, “A0”, etc.  The dimensions associated to the “Screen” format are those sent by 
the pilot of the screen of the workstation. Those associated to the “Printer” format are those sent 
by the pilot of the current printer. The dimensions associated with the other formats are set so 
they can be used by the current peripherals. 
 
The Width and Height fields are used for the direct input of the page dimensions in millimeters.  
 
The radio buttons located on the right interchange the values contained in the Width and 
Height fields in order to position the page in the Portrait or Landscape orientation. 
 

 

Figure 6-2 - Page editing window 
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When the OK button is clicked after changing the page dimensions, a message will appear 
asking the user if he wants to adjust the dimensions of the graphs contained in the page to the 
new dimensions of the page.  If the automatic adjustment of the graphs is not asked, the user 
will change the dimensions of each graph in the graph editing window (see paragraph 3). 
 
The Shadow field is used to change the width of the shading at the bottom and right of the 
page.  The shading will not be drawn when printing. 
 
Clicking on the button at the right of the Shadow field displays the drawing attributes 
configuration window to modify the page shading.  Only the modifications to the pattern, filling 
and line attributes have an effect.  The drawing attributes are described in chapter 9. 
 
The Margin field is for the width of the margin around the page on screen only.  The shading 
and margin widths are applicable for a zoom of 100%; they vary proportionally to the zoom 
percentage.   
 
There are several ways to prepare a new graphic page.  The user can select a page with 
maximal dimensions and place the graphs in a way to keep a margin all around, inside the 
page.  The user can also size the page while considering the margins and then fill the page with 
graphs. In this case, the user must position the margins in the Used part of the Printer tab (see 
paragraph 2.2).  The positions on the screen and the printer are kept in the style file. 
 
With a page smaller than the printable area, it is possible to print objects that are outside the 
page, which is not the case if the page has maximum dimensions, meaning that the page 
occupies the entire printable area. 
 
Whatever the work habits to prepare a graphic page, the user must be aware that: 

• the maximal dimensions available returned by the printer pilot are at the limits of the 
printable area and it is strongly recommended to consider some slightly smaller dimensions;  

• if a graphic page is designed to scale, any resizing, for example to respect printing margins 
incorrectly evaluated, could result in a loss of the precision of the fixed scales. 

 
The page also appears in the graph editing window (see paragraph 3) with the predefined 
number “0”.  The graph “0” can be selected like any other graph. Its dimensions can be 
modified, but those of the left and bottom must be at 0.  In the graph editing window, the user 
can also define a filling for the page; this filling never hides any information since the page is 
always the first element displayed. 
 

2.2. Position and dimensions of the display 

The bottom section of the page editing window is used to position and size the displays on the 
screen and printer, via the Screen and Printer tabs.  The user defines the limits of the page, in 
pixels. The page is shown in the preview area at the top left.  
 
The four fields under Available show how many pixels are available for the current unit, the 
screen or the printer.  The fields under Used allow the user to position the page on the screen 
or the printer.  The user can manually set the display scale.  The field Scale (%) is used to set a 
magnification percentage for the page on screen or printer. 
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The dimensions of the display always respect the proportion between the height and the width 
of the original page. Changing the scale modifies the maximum limits of the display. Changing a 
limit modifies the opposite limit without affecting the scale.  The horizontal and vertical scrolling 
bars can be used if the graphic page is not completely visible in the screen.  
 
The Black and white option forces a black and white display or print of the page, except for the 
logo.  When the Black and white option is activated, the colors of the XVT filling zones are 
no longer displayed.  
 
By default, X3D adjusts the print area according to the resolution of the printer. If the user 
does not want the adjustment when he switches printers, uncheck the box. 
 
  

3. GRAPHS 

Select the Graphs… option or click the opposite button to open the graph editing window shown 
in figure 6-3.   
 
This window is used to change the characteristics of the graphs contained in the current page.  
The user can enable or disable graphs, make them visible or invisible.  He can also change the 
dimensions, position and attributes of each graph.  In addition, the user can change the title of 
each graph, including its position and attributes.  The retrieval and processing of the data 
displayed in the graphs are specific to each application. 
 
In the graph editing window, the current graph is displayed with a yellow background in the 
preview area and is selected in the bottom table.  
  
The user can use the vertical scrolling bar to scroll through the table of graphs.  If the cursor is 
inside a cell, the [Up Arrow] and [Down Arrow] bring the mouse to the previous or next row, 
and the [Page Up] and [Page Down] keys are used to scroll the table by the number of visible 
rows minus one. The [Home] and [End] keys bring the cursor to the beginning or end of the 
active cell. These navigations do not change the selection of the current graph.  
 
Clicking OK or Cancel confirms or cancels the modifications done in the graph editing window. 

 
3.1. Types of graphs 

There are five types of graphs. 

• The basic graph 

This graph is automatically generated by the application and represents the current page.  
Its dimensions are defined in the page editing window.  In the graph editing window, it is 
always the first in the table of graphs. It is numbered 0 in the # column and is named Page.  
Its origin, the left and bottom fields, is set at 0, but its other dimensions can be modified. If 
the page dimensions are modified in this window, they will be automatically modified in the 
page editing window, and there will be no request to readjust the graphs. 

• The primary graphs 

These graphs are directly associated to the page.  They have 0 in the #P column, which 
contains the number of the parent graph. 
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Figure 6-3 - Graph editing window 

• The secondary graphs 

A secondary graph is dependent on a primary graph whose number appears in the #P 
column. 

The dependency relationship between a primary graph and secondary graphs is defined by 
the application.  For example, the Log module for the production of boring logs will treat the 
various property columns as secondary graphs dependant on the DEPTH primary graph, the 
column of depths.  The dependency relationship between the secondary graphs and the 
DEPTH graph is the Y axis, i.e. the depth. 

• The sub-graphs 

A sub-graph is drawn inside a primary graph. The display of the sub-graphs is managed 
entirely by the application.  A negative number appears in the #P column of a sub-graph. 

For example, the Pro module for the production of profile views treats each property column 
of the borings represented along a cross-section and in a 3D view as a sub-graph. 

• The tables 

Technically speaking, a table is not a graph.  The “curves” belonging to a table are actually 
the columns of the table. 

A table is designated by a value greater or equal to 100 in the # column. 
 
The graphs numbers are attributed automatically when they are created, and can be modified. 
The graphs are sorted in ascending order of their numbers in the graph editing window. The 
user must define the number of the parent graph, and adjust the value in the # and #P columns 
to modify the graph type.  
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3.2. Current graph 

The graphs of the current page are represented in the preview area located on the top left of the 
graph editing window.  The graphs are shown as rectangles, with a yellow background for the 
current graph, and an empty background for the others.  If the title of the current graph is not 
selected as Invisible, it is symbolized in the preview area by a rectangle and its anchor point. 
The row representing the current graph in the table at the bottom of the window appears in 
reverse video. 
 
To make a graph current, click once in the desired graph before opening the graph editing 
window.  If the graph editing window is already opened, to make a graph current:  

• select it in the scrolling list associated to the field Graph; 

• select it in the table at the bottom of the window by clicking in the grey cell left of the row 
defining the graph;  

• click it in the preview area; 

In the preview area, if the user clicks in an area shared by several superimposed graphs, all 
these graphs will be selected in the table and the first one will be identified as the current 
graph. Changes to the status of the title and to the position of its anchor point will only affect 
the current graph; however, modifications to the drawing attributes will affect all the selected 
graphs.  

 
The section at the right of the preview area displays:  

• the name of the current graph, as defined in the table at the bottom of the window; 

• the title; if the title is defined by the application, it is displayed but cannot be edited; 

• the status of the title;  

• the position of the anchor point of the title in the X and Y fields; these coordinates are 
expressed in millimeters and are measured from the bottom left corner of the page;  

see paragraph 3.4 for more details about the graphs titles. 

• the Attributes button used to open the drawing attributes configuration window (see 
paragraph 3.3). 

 

3.3. Graph attributes 

Clicking on the Attributes button allows the user to change the drawing attributes of the current 
graph in the drawing attributes configuration window (see chapter 9).  The following attributes 
can be modified:  

• The background color of the graph by selecting Filling; 

• The color, thickness and style of the border line of the graph by selecting Line; the Width 
field can be used to define the line thickness.  

The border of the graph can be hidden by the limits of the panels and mostly by the axes. 

• The title font, size, style, orientation, the interline, the offset of the title relative to its anchor 
point, its alignment relative to the anchor point and its format, using the controls in the right 
section of the drawing attributes window; 
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• The color of the title by selecting Text; the size of the title can also be defined via Height. 
 
The attributes of a Table graph (# higher or equal to 100) affect the title, border and background 
of the table. Paragraphs 4.3.4 and 4.3.6 describe how to modify the presentation of the columns 
headings and the presentation of each column respectively.  
 

3.4. Title of a graph 

The position of the title of the current graph can be modified by editing the X and Y fields or by 
moving the title box in the preview area.  The values in the X and Y fields are the coordinates of 
the anchor point of the title, expressed in millimetres, measured from the bottom left corner of 
the page.  The anchor point has no role for the title of a Table graph.  
 
The Invisible checkbox allows the user to hide the title of the graph.  The User checkbox 
displays the title of the graph from the Title field.  The Application checkbox displays the graph 
identification if provided by the application. 
 
The title of the graph defined by the user is entered in the Title field.  For a title to be displayed 
on several lines, enter the “|” character where a line feed is required. 
 
The title of a Table graph is positioned according to the horizontal alignment of the text.  It is 
copied in the table editing window (see paragraph 4.3.2).  
 
Click on the Attributes button to modify the text attributes of the title (see chapter 9). 
 
It is possible to edit the page title (graph 0), but the title will never be displayed. 
 

3.5. Graph characteristics 

The table at the bottom of the window is used to change the characteristics of the graphs. In this 
table:  

• The # column contains the number of the graphs 

• The #P column contains the number of the parent graphs (see paragraph 3.1). 

• The Name column contains the identification of the graphs.  A scrolling list is available, and 
the applications first show the names of the graphs specific to the application, followed by 
the list of tables and views in the database established by the application.  

• The columns between Left and Top contain the position and dimensions of the graphs. 

The values contained in the position and dimension cells can be modified. However, the 
origin of the page is always reset to 0. When a value in a cell is modified, an update is 
automatically done in the complementary cell when the cursor leaves the modified cell. For 
example, if the user changes the width of a graph, after leaving the cell, the value in the 
Right column for this graph is automatically recalculated according to the values in the Left 
and Width columns.  

The position and dimensions of a Table are defined in the graph editing window.  However, 
as mentioned in paragraph 4.3.1, the display of the table does not necessarily reflect these 
values. 

• The Visible column indicates if the graphs will be visible or not. 
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The cells in this column can contain Yes or No.  Double-clicking in the cell changes the 
value to the other possible one. By default, when the value is modified in the Visible 
column, the value in the Active column is also modified.  

• The Active column indicates if a graph can become current; an inactive graph cannot 
become current.  When the user clicks on an active graph, its name is shown in the status 
bar and we can open its corresponding data entry form with a double click. The Active 
option is mostly useful when working with superimposed graphics.  The user can deactivate 
one of the graphs in order to work with the other one. 

The cells in the Active column may contain Yes or No. The value can be changed with a 
double click. 

• The Site module is the only one that uses that OGL column. This column is only used when 
Site is in 3D and OpenGL modes.  Enter the radius of the cylinder of properties (in 
geographic meters) which corresponds to the maximum value of the axis. Note that no 
clipping is done.  See the guide of Site for more details.  

 

3.6. Copy and Delete 

The Copy and Delete buttons apply to the current graph, i.e. the one that is selected in the 
table. 

• Clicking on the Copy button or pressing the [Insert] key creates a complete copy of the 
selected graph, including its curves, legend and axes, and is inserted immediately after the 
original graph. 

The new graph has the same characteristics as the original graph, but a different #.  After 
the creation of a new graph, the numbers of the graphs as well as the references to the 
parent graphs are updated, if necessary.  If there are “gaps” in the numbering, they are 
partially or totally filled. 

• Clicking on the Delete button or pressing the [Delete] key deletes the selected graph.  If the 
Delete button was selected by mistake, exit the window immediately by clicking on the 

Cancel button or .  Deleting a graph leaves a gap in the numbering.  If secondary 
graphs were dependent on the deleted graph, the references to the deleted graph are kept.  
The user must modify the references to the deleted graph or delete all the secondary graphs 
that no longer have a parent graph. It is the same for the sub-graphs that depend on a 
deleted primary graph. 

 

 

4. LEGEND AND CURVES 

If the current graph is not a table (# of the graph inferior to 100), select the Legend… option or 
click on the button on the left to open the legend and curve editing window.  If the current 
graph is a table (# of the graph higher or equal to 100), the Legend… option or the button on 
the left opens the table editing window.  
 

4.1. Current graph 

The graphs of the current page are shown as rectangles in the preview area located on the top 
left of the legend and curve editing and table editing windows. The current graph has a yellow 
background.  
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To make a graph current, click once in the desired graph before opening the legend and curve 
editing or table editing windows.  If the editing window is already opened, to make a graph 
current:  

• select it in the scrolling list associated to the field right of the preview area; 

• click it in the preview area;  

with this method, if graphs are superimposed, the user must make inactive the graph that 
should not be current.  

 

4.2. Legend and curve editing 

The legend and curve editing window, shown in figure 6-4, is used to create and change the 
characteristics of the curves and legend of the current graph. 
 

 

Figure 6-4 - Legend and curve editing window 
 
A graph can contain several curves.  Some characteristics of the curves are specific to each 
application. See the specific guides for more information.  
 
The characteristics of the legend of the current graph are displayed under graph name at the 
top of the window, while the characteristics of the curves of the current graph are displayed in 
the table at the bottom of the window. 
 
The user can use the vertical scrolling bar to scroll through the table of curves.  If the cursor is 
inside a cell, the [Up Arrow] and [Down Arrow] bring the mouse to the previous or next row, 
and the [Page Up] and [Page Down] keys are used to scroll the table by the number of visible 
rows minus one. The [Home] and [End] keys bring the cursor to the beginning or end of the 
active cell. These navigations do not change the selection of the current curve.  
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Clicking OK or Cancel confirms or cancels the modifications done in the legend and curve 
editing window. 
 
4.2.1. Positioning the legend 

The 1st Visible checkbox indicates if the legend will be displayed or not. If the legend is visible 
to a primary graph that has secondary graphs, the legend will show the curves of the primary 
and secondary graphs. 
 
To position the legend in the graph, the user specifies the coordinates of its anchor point in the 
X and Y fields under Position (in millimeters relative to the bottom left corner of the page), or 
moves the anchor point with the mouse in the preview area.  

 
The alignment of the legend relative to its anchor point can be modified with the button 
shown on the left.  Click one of the nine positions to select the position of the legend 
relative to its anchor point.  The result is shown in the preview area.  If no alignment is 

defined, the bottom left corner is set by default as the anchor point. 
 
4.2.2. Title and attributes of the legend 

The title of the legend is specified in the Title field. This title can be written on several lines, the 
line feed character being “|”. 
 
The 2nd Visible checkbox indicates if the title of the legend will be displayed or not. 
 
The Nbr. of columns field is used to specify how many columns the legend will have. 
 
The Shapes width field is used to specify the length of the symbols displayed in the legend.  
These symbols normally consist of a segment with a marker in the middle.  The attributes of the 
symbols are those defined for the curves (see paragraph 4.2.3). 

• If the shapes width is negative, the symbols are placed on the left of their text identification; 
if it is positive, the symbols are on the right. 

• If only the markers are to be displayed as symbols in the legend, without the segment, set 
the shape width to 0 or remove the line, if only the points are displayed in the curve.  

 
The Margin field is used to specify the space between the sides of the legend box and its 
content, and between the longest text identification and its symbol. 
 
The button right of the alignment button for the legend opens the drawing attributes 
configuration window (see chapter 9) to change the attributes of the box and the texts of the 
legend.  In this window, you can modify: 

• the background color of the legend by selecting Filling;  

• the color, style and thickness of the border line of the legend, by selecting Line and by using 
the Width field; 

• the color of the texts in the legend and the size of the characters, by selecting Text and 
using the Height field; 

• the font of the texts in the legend, their size, style, orientation, the interline and the offset 
using the controls on the right of the attributes configuration window.  
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4.2.3. Presentation of the curves 

The table at the bottom of the legend and curve editing window is used to define the curves of 
the current graph.  In the Lab module, the curves for the various samples are actually defined in 
the page, since they are represented in each graph. See the specific guide for more details.  

• The # column contains the curve numbers, which can be modified. However, the 
management of the numbers is done by the application.  For example, some applications 
can give specific numbers for predetermined curves; others can order the curves according 
to the numbers provided by the user, etc. 

• The Name column contains the identification of the curves associated to the graph.  By 
“curve”, we mean at set of similar data whose representation is not necessarily a curve.  For 
example the curve of stratigraphic codes presented by Log is a column of symbols. 

For a curve to be represented, it usually needs to correspond to a field of a table or view in 
the database.  However, some curves with a predetermined number and name are 
automatically generated by the module.  For example, the Layers curve is automatically 
generated with the number 101 by Log when a Stratigraphy graph is created; the attributes 
of this curve define how the limits of the layers will be drawn in boring logs.  The curves with 
numbers of 100 or greater are automatically generated by the application.  

A list with the fields from the table of the database represented by the graph is available in 
the Name column.  The new curves selected by the user have a number between 1 and 
100. 

If curves have a negative number, they are generated by the application and cannot be 
deleted or modified (except their attributes).  Lab module uses this function a lot.  

The guides of the modules present in details their legend and curve editing window.  

• The Series column has two roles:  

 It is used to specify which series of data must be displayed in the curve.  This use only 
applies to few data tables whose values are based not only on X, Y and possibly Z, but 
also on another qualifying value.  For example, with Log and Pro, if a curve represents 
a field from the PROPERTY_VALUE table, the property to represent will be specified in 
Series. 

 Adding @@ in Series is used to display equivalences to values when they are defined in 
the EQUIVALENCE table, or else in the LIST_ENG or LIST_FRE table.  

If the equivalent expressions are textual, they will be displayed only if the curve is of 
type Default or Text (see below).  If the equivalent expressions are numeric, they will 
be displayed no matter the curve type. 

• The Type column defines the format in which the data will be presented in the graph.  A 
scrolling list associated to the cells of the column suggests:  

 Default presentation defined by the application; 

 Text  values expressed textually; 

 Point  scatter plot; 

 Histo  envelope of the histogram; 

 Step  envelope of the bars; 

 Polyline  polyline; 

 Polygon  polygon; 
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 Color   color corresponding to value; 

 Pattern  pattern corresponding to value; 

The application defines the format in which the data can be displayed.  The user selects the 
desired type in the list.  If the chosen type is not treated by the application, the selection will 
have no effect.  

• The Period column contains the period of the markers along the curve, if the curve type is 
Polyline. It indicates their display frequency; a period of 1 means one marker per point of 
the curve, a period of 2 means one marker per two points of the curve, etc.  With a period of 
0, the markers are not displayed. The Period is used by the Histo type to indicate which 
lines of the histogram will be displayed, and for the Step type to indicate the verical 
alignment of the steps. 

• The role of the Size column is defined by the application, depending on the graph or the 
curve type. If the curve is “conventional”, the value entered in the Size column is the size of 
the markers of the curve points.  If the curve is of Text type, the Size column corresponds to 
the height of the text. 

• The Align column plays a role if the curve is of type Text and if the application allows it.  
The texts of the curve will be aligned to the left, center, or right if the value of the alignment 
is 1, 2 or 3 respectively. With the curves of type Histo or Step, an alignment of 3 is used to 
present inverted graphs.  

• If the Order cell of a curve contains 0 or a negative value, the curve is not represented in the 
legend.  The curves with a positive order value are represented in the legend and 
organized according to their order. 

An application can force the display of some curves in the legend, if the legend is visible.  
For example, Lab will display the curves of the samples displayed in each graph presented.  

• The display of the curve in the graph depends on the value in the Hide column.  By default, 
the value is No.  If a curve is not represented in the graph, it is not in the legend either. 

Some applications force the display of curves with data present; in this case, changing Hide 
to Yes has no effect.  If the user does not want to see these curves, he must hide them with 
the configuration of their drawing attributes, as described below.  

• The Title column contains the titles of the curves that appear in the legend.  By default, the 
title of a curve is identical to its name when a curve is created.  

Some applications use the Title column to request the display of the value of a field from a 
table in a specific format.  See the guides of these applications for more details. 

 
The Insert button is always active while the Delete button is active as soon as one or many 
rows of the table are selected (by clicking in the grey cell containing the curve number).  

• Clicking on the Insert button or pressing the [Insert] key inserts a new curve at the 
beginning of the table or after the selected curve. If several curves are selected, it will be 
inserted after the first selected one.  Inserting a new curve will update the numbers of the 
curves. If there were “gaps” in the sequencing order, they are filled in partly or completely. 

• Clicking on the Delete button or pressing the [Delete] key deletes the selected rows.  The 
numbering of the curves is not adjusted. 
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The predefined curves specific to some applications (their # is higher or equal to 100, or 
negative) can be deleted, but they are automatically regenerated by the application.  A good 
way to reset curves is to delete them.  

 
The drawing attributes of the selected curve are defined via the window opened by clicking on 
the button located under the Delete button (see chapter 9).  The attributes to be edited are:  

• the color, style and thickness of the lines of the curve by selecting Line and with the Width 
field, if the curve is of type Histo, Step, Polyline or Polygon; 

• the type and diameter of the markers for the points of the curve by selecting Marker and 
with the Diameter field, if the curve is of type Point or Polyline; 

• the color, size, font, interline, angle, offset, style, alignment and format of the characters by 
selecting Text, with the Height field and with the controls at the right of the attributes 
configuration window, for all curve types; 

• the filling in the area contained by the curve by selecting Filling, if the curve is of type Histo, 
Step or Polygon; 

• the pattern in the area contained by the curve by selecting Pattern, if the curve is of type 
Histo, Step or Polygon;  
 

The application keeps the final control on the editing possibilities.  In the case of Default type 
curves, the application defines the display. 
 

4.3. Table editing 

The table editing window, shown in figure 6-5, is used to create and change the characteristics 
of the current table. 
 
The Lab module uses the tables the most. See the specific guide for more information.  
 
The user can use the vertical scrolling bar to scroll through the rows at the bottom of the table 
editing window.  If the cursor is inside a cell, the [Up Arrow] and [Down Arrow] bring the 
mouse to the previous or next row, and the [Page Up] and [Page Down] keys are used to scroll 
the table by the number of visible rows minus one. The [Home] and [End] keys bring the cursor 
to the beginning or end of the active cell. These navigations do not change the selection of the 
current row.  
 
Clicking OK or Cancel confirms or cancels the modifications done in the table editing window. 
 
4.3.1. Position and dimensions of the table 

The position and dimensions of the graph defining the table, as they appear in the graph editing 
window (see paragraph 3.5), are those of the table, without including the Symbol column, if 
visible. 
 
If no alignment is defined (no point selected in the alignment button), the table will occupy the 
rectangle defined for the graph, with its origin being the bottom left corner of the table.  The 
columns are resized in order to adjust to the dimensions of the graph. In the preview area, the 
table appears in yellow with a solid border, and the bottom left corner is the anchor point.  If the 
Symbol column is visible, the preview area shows that the column is outside the limits left of the 
table.  
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If an alignment is defined, the selected point on the alignment button represents the 
position of the anchor point of the table in the rectangle that defines the graph.  When an 
alignment is defined, the table is resized to display all the data of the table according to 

the various drawing attributes defined for the headings, columns, and table title. The table can 
therefore be larger or smaller than the rectangle defining the graph. The position of the anchor 
point is shown in the X and Y fields.  These coordinates cannot be modified.   
 
In the preview area, the table appears in yellow with a dotted border to show that it is the 
rectangle of the graph definition, not necessarily the area that the table will occupy.  The anchor 
point of the table is shown according to the selected alignment.  If the Symbol column is visible, 
the preview area shows that the column is outside the limits left of the table.  
 

 

Figure 6-5 - Table editing window 
 
4.3.2. Title of the table 

The title of the table is specified in the Title field. This title can be written on several lines, the 
line feed character being “|”.  The status of the title (invisible, user or application) is defined in 
the graph editing window (see paragraph 3.4).  The attributes of the title are also defined in the 
graph editing window, by clicking on the Attributes button (see paragraphs 3.3 and 3.4).   
 
The second Visible checkbox is used to indicate if the title of the table is displayed or not.  If 
yes, its area is included in the rectangle’s limits, unlike the column of symbols. 
 
4.3.3. Rows and margin of the table 

The Nbr. of rows field specifies how many rows the table must display.  This number does not 
include the eventual title or the row of columns headings. 
 
If the table is without alignment (displayed in the dimensions of the graph), it is possible that the 
number of rows specified cannot be displayed or that the rows do not fill the entire table, 
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depending on the height of the rectangle, the presence of the title and the height of the 
characters in the rows. 
 
If the table has an alignment, all the displayable rows are shown, up to the number of rows 
specified. 
 
The Margin field specifies the minimum offset between the content of the cells and their 
borders, in millimeters. This offset applies to all sides. This offset applies to the title, the 
headings and all the cells of the rows, including the column of symbols if visible.  
 
The drawing attributes of the lines separating the rows are controlled by the drawing attributes 
of column 0 (Symbol), whether or not this column is visible (see paragraph 4.3.5). 
 
4.3.4. Columns headings 

The Headings button calls the Attributes window (see chapter 9) to change the drawing 
attributes of the table’s columns headings. In this window, the user can modify: 

• The color and XVT pattern of the background of the headings, with Filling; 

• The color, style and thickness of the headings’ upper and lower borders, by selecting Line 
and with the Width field; if a border is defined for the table, it will hide the upper border of 
the columns headings. 

• The color, size of characters, font, interline, angle, style and alignment of the text of the 
headings, by selecting Text, with the Height field and with the controls at the right side of 
the attributes window. 

If no alignment is defined, the absolute value of the offset distance is interpreted as the 
distance between the text and the left vertical border of the cells; the offset angle is not 
considered.  

 
4.3.5. Display of the symbol column 

The 1st Visible checkbox under Symbols is used to display or not the column 0 (Symbol).  If 
this box is checked, the Hide cell of row 1 shows No; if the box is not checked, the cell shows 
Yes. 
 
The Shapes width field is used to specify the size of the symbols displayed in the symbols 
column. If the field contains 0, only a marker represents each symbol. The application defines 
the symbols that characterize the data presented. 
 
The drawing attributes of the column of symbols can be modified. Select column 0 by clicking 
the grey cell left of its row, and click on the button located under the Delete button to open the 
Attributes window (see chapter 9).  In this window, the user can modify:  

• the color and XVT pattern of the background of the Symbol column, with Filling;  

• the color, style and thickness of the lines dividing the rows of data by selecting Line and 
using the Width field. 

 
4.3.6. Presentation of the columns 

The table at the bottom of the table editing window is used to define the columns of the current 
table.  The table of columns shows the following information:  
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• The # column contains the numbers of the columns, which can be modified (except number 
0). It is impossible to replace a number by a number already used by another column. When 
the user clicks OK in the table editing window, the columns are displayed from left to right 
according to the order of their numbers. 

The next time the window is opened, the rows are ordered according to their # in the table of 
columns.  

• The Name column contains the identification of the columns associated to the table.  

Depending on the application, the choice of the columns may be done directly in the 
Options window (see the guide of Lab).  It is also possible to display values of a field of a 
table or view in the database. In this case, a list with the fields from the table of the database 
represented by the Table graph is available in the Name column.  

• The Series column has two roles:  

 It is used to specify which series of data must be displayed in the column.  This use only 
applies to few data tables whose values are based not only on X, Y and possibly Z, but 
also on another qualifying value.  For example, with Lab, if a table column represents a 
field from the PROPERTY_VALUE table, the property to represent will be specified in 
Series. 

 Adding @@ in Series is used to display equivalences to values when equivalent 
expressions are defined in the EQUIVALENCE table or in the LIST_ENG or LIST_FRE 
table for the field designated by the column. 

• The Type column has no role is the case of a table.  Data is always expressed as text.  

• Col. Id identifies the columns with their initial number. These values cannot be modified.  

• The Width column defines the width of the columns. 

 The effective width of the columns with a defined width greater than 0 depends on this 
defined width.  

In a table without alignment (displayed with the dimensions of the graph’s rectangle), 
the proportion between the defined widths is used (except for column 0). In a table with 
alignment, the defined widths are used for the display. 

 The effective width of the columns with a width of 0 depends on the length of the values 
contained, including the heading.  

The display of a column of width 0 is adjusted, as much as possible, to fit the longest 
value on one line.  The heading can be displayed on several lines if it is made of several 
words with a total length exceeding the length of the longest value of the column or if it 
contains the character “|”. 

In a table without alignment, it is possible that no column can display the totality of its 
content.  However, in a table with alignment, the columns with a defined width of 0 will show 
their entire content, while the columns with a defined width greater than 0 will show only 
what their width allows. 

• The Align column has no role in the case of a table. 

• The Order column has no role in the case of a table. 

• The display of the column in the table depends on the value of the Hide cell.  By default, the 
value is No. 
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• The Columns Headings column contains the labels of the columns headings. 

Some applications control entirely the label of the columns headings, or ask the user to 
define them in the Options window. Refer to the specific guides.  
 

The Insert button is always active while the Delete button is active as soon as one or many 
rows of the table are selected (by clicking in the grey cell containing the number of the row).  

• Clicking on the Insert button or pressing the [Insert] key inserts a new row at the beginning 
of the table or after the selected row. If several rows are selected, it will be inserted after the 
first selected one.  Inserting a new row will update the numbers of the rows. If there were 
“gaps” in the sequencing order, they are filled in partly or completely. 

• Clicking on the Delete button or pressing the [Delete] key deletes the selected rows.  The 
numbering of the rows is not adjusted. It is not possible to delete the column 0.  
 

To modify the drawing attributes of a column, select the column and open the Attributes 
window (chapter 9) by clicking on the button under the Delete button.  For all columns except 
the symbol column, the attributes that can be modified are: 

• the color and XVT pattern of its background, by selecting Filling;  

• the color, style and thickness of its left border by selecting Line and with the Width field; 

• the color, size, font, interline, angle, style, alignment and format of the content of its cells by 
selecting Text, with the Height field and using the controls at the right of the attributes 
configuration window.  

If no alignment is defined, the absolute value of the offset distance is interpreted as the 
distance between the text and the left vertical border of the column; the offset angle is not 
considered. 

 
The application has the final control on the editing possibilities.  The drawing attributes that can 
be modified for the symbol column are outlined in paragraph 4.3.5. 
 
 

5. AXES 

Select the Axes… option or click the opposite button to open the axes editing window shown in 
figure 6-6.  This window is used to configure the axes of the graphs in the current page and to 
change the attributes of the titles, labels, grids and tick marks. Clicking OK or Cancel confirms 
or cancels the modifications done in the axes editing window. 
 

5.1. Choice of the graph 

The axes characteristics can be edited for the current graph.  To make a graph current, click 
once in the desired graph before opening the axes editing window.  If the editing window is 
already opened, select the desired graph in the scrolling list associated to the field at the top left 
of the window.  
 
In the case of a primary graph that has secondary graphs, the axes must only be modified for 
the primary graph. The values of all the graphs will be displayed according to the axes of the 
primary graph. 
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The Title field is used to change the graph title (the title is also written in the graph editing 
window).  
 
Some applications do not permit the 3D display of graphs (for example, Log).  The view point 
options in the View menu are absent, and the 3D checkbox in the axes editing window cannot 
be checked.   
 
The Site and Dam modules allow the 2D or 3D display of a PLAN_VIEW (graph #1) of 
cartographic type.  The 3D checkbox can then be used to activate the 3D display.  
 
The Hide box at the top right of the window is used to hide the axes of the graph, without having 
to remove the drawing attributes.  
 

 

Figure 6-6 - Axes editing window 
 

5.2. Choice of the axis 

Each graph has three axes.  For a 2D graph, the Z axis is not used.  The axes editing window 
has three tabs (one for each axis) that access the definition panels for the characteristics of 
each axis.   At the bottom of the Y axis and Z axis panels, the Copy X button copies all the 
characteristics of the X axis for the current axis.  
 

5.3. Axis title 

The Axis title is written in the corresponding field. The axis title can be displayed on several 
lines by using the “|” character for a new line. 
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The presence and display characteristics of the axis title are managed by the controls of the 
zone under the label Title.  
 
For a 2D graph, the checkboxes at the bottom of this zone are identified as Bottom and Top for 
the X axis and as Left and Right for the Y axis.  For a graph that can be shown in 3D, the 
checkboxes are all identifies as Origin and End. The axes titles for cartographic graphs are 
displayed only in 3D mode, not in 2D.  
 
If none of these boxes is checked, the axis title is not displayed.  If the two boxes of the current 
axis are checked, the two axes of the 2D view, or two of the four axes of the 3D view, will have 
a title. 
 
The title is always displayed in the middle of the axis, no matter the text alignment with 
respect to its anchor point. 
 
With a time axis (see paragraph 5.4), the axis title will not be displayed.  
 
The text attributes of the axis title (color, font, style, etc.) can be modified via the drawing 
attributes configuration window (see chapter 9) opened by clicking on the button under Title.  It 
is not possible to display inclined titles.  To move a title with respect to the axis, it is preferable 
to use the line spacing value, which indicates the distance between the axis or the labels and 
the title; this distance is function of the height of the characters.  With a negative line spacing 
value, the axis title is displayed inside the graph.  
 

5.4. Axis type 

For each axis, the user selects the axis type in the scrolling list associated with the Axis type 
field.  The axis can be of linear, logarithmic, time or domain type: 

• The linear, logarithmic and time types are standard types of axes. 

• The domain type is used for the axes of a map; if one axis is of domain type, the others are 
as well. Cartographic graphs must have axes of domain type.  
 

The Angle field is designed to receive the angle between the axes of a cartographic domain 
and the cardinal directions ("oriented domain").  The angle value is the same for the X, Y and Z 
axes.  Usually, the angle of the oriented domain is managed by the application and modifying 
this value has no effect.  
 

5.5. Axis limits 

The limits of an axis are the extreme values that the axis can have.  They can be specified in 
different ways in the Min and Max fields.  The scrolling lists beside these fields are used to 
specify the type of values: 

• Exact value – the value in the field represents the exact minimum or maximum value of the 
graph.  The value is determined by the application and from the data represented in the 
graph; it cannot be modified by the user.  For a cartographic map, the axes limits are always 
exact.  

• Rounded value – the value represents the first rounded value, according to the specified 
primary step, outside the exact value (less than the minimum exact value, greater than the 
maximum exact value); it is determined by the application and cannot be modified.  
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• Fixed value – the value is specified by the user; the field can be edited and the user can 
change the values. 

 
The Del field contains the difference between the limit values for the axis. It can only be 
modified if both the Min and Max fields are with fixed value. Modifying the Del field 
automatically modifies the Max field. 
 
Checking the Invert box will invert the values along the current axis, i.e. the maximum limit is at 
the origin of the axis. 
 
With an axis of type time, the values are treated in Julian days but are displayed in the double 
format (such as 20081024.105) for better readability.  To input the fixed limits of a time axis, 
double-click in the fields of limits to open the date editing window, shown in figure 6-7. 
 

 

Figure 6-7 - Date editing window 
 
The values of the axes limits are sometimes managed automatically by the application or 
defined in a specific window.  For example, with Log, the limits of the Y axis of each graph are 
fixed in the options window where the height of the columns, the depth per page, etc. are 
defined (see the specific guide). 
 

5.6. Division or step 

The step represents the value on the axis between each tick mark.  The primary step covers 
the entire axis length. The secondary step is defined between two primary tick marks. As with 
the axes limits, the values displayed in the Prim and Sec fields have different meanings 
depending on the selection from the scrolling list associated to these fields: 

• divisions – in the Prim field, it is the approximate number of divisions between the axes 
limits; in the Sec field, it is the approximate number of divisions per primary step. The 
number of divisions is rounded to obtain steps that are multiples of 1, 2, 5 or 10.  The user 
can modify the value proposed by default. 
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• calculated – it is the value of the step calculated according to the number of divisions.  This 
value cannot be directly modified by the user. This option displays the result for the number 
of divisions entered.  By changing the number of divisions with the divisions option, the 
value for the calculated option is automatically modified. 

• fixed – it is the step value fixed by the user. 
 

5.7. Distortion / length 

The values of distortion (D/X) are significant only for the Y and Z axes.  The distortion 
represents the ratio between the value in coordinates of one millimeter on the Y or Z axis and a 
millimeter on the X axis. Modifying the distortion of the Z axis of a graph is shown in the View 
Point window of the View menu (see chapter 5). 
 
The length (L/X) is valid only for 3D graphs and represents the ratio between the length of the Y 
or Z axis in millimeters and the length of the X axis.   
  
The values of distortion and length can be fixed (by the user) or free (calculated by the 
application).  If a distortion is fixed, the limits of the axes may be adjusted, the rounded limits 
being adjusted before the fixed or calculated ones, and the limits of the Y and Z axes before 
those of the X axis.  The application always tries to display all values.  
 

5.8. Attributes of the panels and axis lines 

The panel represents the perpendicular plan behind the current axis when the graph is in 3D. 
 
The display attributes of this panel can be changed by clicking on the button located below the 
Panel label. The following attributes can be modified: 

• the background color (filling) of the panel;  

• the type of pattern on the panel background;  

• the color, thickness and style of the border line of the panel border; the line may be hidden 
by the axes. 

 
Clicking on the button under Axis line allows the user to change the display attributes of the 
axis line: 

• its color, thickness and style; 

• the offset distance from the axis to the border of the graph (valid in 2D only).  A positive 
value moves the axis towards the top or right, and a negative value moves it towards the 
bottom or left, with respect to the border of the graph. 

 
The Bottom and Top, Left and Right or Origin and End checkboxes in the definition of the 
three axes are used to define which axis line will be displayed.  
 

5.9. Attributes of the labels 

The display attributes of the labels can be modified by clicking on the button located under 
Labels. With Text, the user can define the display of the labels.  The alignment and the offset of 
the labels with respect to their anchor point can be modified.  The labels are normally displayed 
outside the graph and are centered relative to the primary tick marks.  They can be displayed 
inside the graph by entering a negative offset distance. 
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The Format field is used to specify a display format (number of decimals, exponent, etc.) for the 
labels.  The syntax of the C language (%g, %.2f, %.0e, %s for example) or the format 9.99 and 
even a.aa are acceptable. 
 
The Period field is used to define the display period for the labels along the axis at the primary 
tick marks.  A period of 2 means that a label will be displayed every 2 primary tick marks. The 
orig and end checkboxes are used to specify if labels are displayed at the ends of the axis. 
 
The Bottom and Top, Left and Right or Origin and End checkboxes define along which axis 
the labels will be displayed.  The tick marks will be displayed along the same axes as the labels.  
 

5.10. Attributes of the grids and tick marks 

For each axis, the user can define primary and secondary grids and tick marks, by selecting the 
pri or sec tab. 
 
The presence of the primary and secondary grids is controlled by the Grid checkbox. 
 
The grids and tick marks attributes can be modified by clicking on the corresponding buttons 
under Grid and Tick marks.  By selecting the Line, the grids or tick marks attributes are 
defined, accordingly.  The grids are traced perpendicularly to the axis; in 3D, they are traced on 
the back panels delimited by the axis.  
 
The Length field specifies the length of the primary and secondary tick marks, depending on 
the tab selected. 
 
The Inside and Outside checkboxes define the side of the axis on which the tick marks will be 
displayed.  
 
 

6. PREFERENCES 

Select the Preferences option or click on this button to open the preference editing window. 
This window has 3 panels, General, Default and File, available via the tabs.  The three panels 
contain controls to define some operating parameters of X3D and the current module.  
 
The selection of the parameters is effective once the user exits the preference editing window 
by clicking on OK.  The values of the parameters defined in the preference editing window are 
saved in the registry of the user’s workstation for the module (see chapter 1). 
 

6.1. General panel 

6.1.1. Choice of the language 

The modules can be used in English or French by clicking on the radio button next to the 
chosen language.  
 
The user can also select the Language option of the Tools menu, which opens a sub-menu 
allowing the language selection (see paragraph 1).  
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6.1.2. Display of the toolbars 

The top toolbar is the bar of buttons located right under the menus. It contains the shortcuts to 
the application tools, i.e. those specific to the different modules.  If the Top box is checked, the 
application toolbar is visible.    
 
The left vertical toolbar is either the X3D toolbar (see chapters 5 and 6) or the graphic editing 
toolbar (see chapter 4), depending on the application mode determined by the Objects option of 
the Tools menu.  If the Left box is checked, the toolbar is visible.  
 
If the Bottom box is checked, the status bar located at the bottom of the screen is visible. What 
is displayed in the status bar depends on the application and the context, but can include: 

• The current record numbers 

• Messages; 

• For a 2D graph, the number and name of the graph as well as the position of the cursor in X 
and Y in the units of the graph;  

• For a 3D graph, the number and name of the graph as well as the position of the cursor in R 
and U (right and up) in millimeters with respect to the origin of the page;  

• When the cursor is outside all graphs but in the page, the number (0) and name (Page) of 
the graph as well as the position of the cursor in R and U (right and up) in millimeters with 
respect to the origin of the page. 
 

6.1.3. Decimal symbol 

The user can use the Point, Comma or the decimal symbol of the System for the display in the 
module and the X3D windows.  
 
If System is selected and a character other than the point or the comma is defined as the 
decimal symbol on the workstation, this character will be displayed as the decimal symbol but 
the application will not perform operations.  
 
6.1.4. Tooltips 

In the rectangle Tooltips: 

• the Initial delay (ms) is used to enter the delay in milliseconds before the display of the 
tooltip of an element after the cursor is placed on that element.   

• the Display time (ms) is used to enter the display duration of the tooltips in milliseconds. 

• the Detection range (mm) determines the distance within which the cursor must be from an 
element for its tooltip to be displayed. 

• if the box Detect cartographic entities is checked, a tooltip will display information about 
the cartographic entities when the cursor is placed on them.  

• if the box Detect geotechnical entities is checked, a tooltip will display information about 
the geotechnical entities when the cursor is placed on them.  
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Figure 6-8 - General panel of the preference editing window 
 
6.1.5. Software or Windows clipping 

X3D has specific clipping functions known as Software clipping.  By default, the box is not 
checked (Windows clipping used). 
 
With the Windows clipping, the patterns and fillings, the markers and the texts are clipped very 
precisely along the borders of the shapes containing them.  In some situations, the use of the 
Windows clipping can slow down the printing or generate very large files.  These effects occur 
particularly when printing .pdf files. 
 
With the software clipping, the printings are faster, but the clipping is less precise, especially 
when the shapes implied in the clipping are complex, and all the text strings that should be 
clipped disappear completely. 
 
6.1.6. Bitmap or standard display 

X3D supports two display modes, the first one is known as standard, the second as bitmap. By 
default, the box is checked (Bitmap mode). 
 
With the standard mode, the display of the graphic page is done line by line.  Since this display 
can be slow on some computers, the display of the graphic page is not systematically launched 
every time an event affects the display.  For example, if the user opens an editing window and 
moves this window, there may not be a new display to cover the area located where the initial 
position of the window was.  Refreshing the display will be done when the window is closed, by 
selecting the Refresh option of the View menu or by clicking the Refresh button.  
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With the bitmap mode, the graphic page is displayed globally.  Since this display is fast, it is 
possible to update it in most cases.  However, the bitmap mode uses a lot of memory; therefore, 
with large zooms, the workstation’s memory limit can be reached.  In this situation, the bitmap 
mode is automatically replaced by the standard mode.  
 
6.1.7. Vertical scrolling 

The field Number of pixels per line is used to define the extent of the scrolling triggered by 
clicking on the arrow buttons at the top or bottom of the potential vertical scrolling bars of the 
various windows supported by X3D and by the application using it. 
 
6.1.8. Zoom factor 

The Zoom factor field is used to define the enlargement or reduction factor of the graphic page 
in “software zoom” or “hardware zoom” modes. If the factor is 1, the movement of the mouse 
towards the top or bottom will not change the display of the page. The greater the factor, the 
faster the enlargement will be for a given movement of the mouse.  If the factor is smaller than 
1, the display will be reduced when the mouse is moved towards the top.  See chapter 5 for 
more information.  
 

6.2. Default panel 

6.2.1. Appearance of the entry forms 

The user can modify the appearance of all windows and entry forms used by the application. To 
do this, click on the big button in the Entry forms rectangle to open the editing window for the 
appearance of entry forms and to define their components, shown in figure 6-9. 
 

 

Figure 6-9 - Editing window for the appearance of entry forms 
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This window mostly has buttons to define a color with the standard Windows screen for color 
selection, as shown in figure 6-10.  The window will be in English or French, depending on the 
Windows installation. 
 

 

Figure 6-10 - Color selection window 
 
6.2.1.1. Predefined colors and initialization 

The user can select a set of predefined attributes for the display of the entry forms, by selecting 
an element from the scrolling list associated to the Theme field, illustrated in figure 6-11. The 
selection can have an effect on all attributes.  
 

 

Figure 6-11 - List of themes 
 
Selecting a theme does not restrain the user from modifying the color of one of the elements, 
but the palette will not be modified.  The changes will be kept until this theme or another is 
selected.  
 
Clicking on the Reset button changes the display attributes of the entry forms to the basic 
values defined in X3D. These attributes are the same as for the Windows XP and Sobek 
themes.  
 
6.2.1.1.1. Fonts 

The user can select the character font to use in the windows, by clicking on the Font button, 
which opens the standard font selection and configuration window of Windows. This window will 
be in English or French depending on the Windows installation. 



 Tools Menu 6-27 
 
 

Preferences 2019-09-26 
 

 

 
The user can select the font, style, size and effects. 
 
The selected configuration applies to all the texts, including the values in the fields and cells of 
tables.  You may need to exit the application and enter it again for the font change to apply to 
values entered in the fields and cells of tables. 
  
If the user selects a large size of characters, the entry forms only show partly the various labels. 
The user will close and reopen the application; the windows and their content will be larger to 
take into consideration the font size.  It is similar if the font size decreased.  
 
The minimal size for the characters used for the entry forms is 8 points. 
 
6.2.1.2. Interface 

The elements of the Interface section are used to define: 

• The general background of the windows and eventually of the rectangles that they contain 

• The color of the texts 
 
6.2.1.2.1. Background image 

To display an image in the background of the entry forms, the user first checks the Background 
image box, which activates the two fields under this checkbox.  
 
The upper field shows the name of the file selected as background for the forms. The selection 
of the file is done by clicking on the button right of the field which opens the standard window for 
file selection. 
 
The lower field labelled Mode has a scrolling list used to choose the display mode of the chosen 
background image: normal, resize or tile. The resize mode is the default mode.  
 
The background image applies to the general background of the forms and to the background of 
the rectangles that the forms may contain. It does not apply to the background of the tables or 
buttons.  
 
The background image is displayed in each rectangle where it applies. The origin of the image 
is the upper left corner of each rectangle. If the normal mode is selected, it is possible that the 
background of a form or rectangle is not completely covered by the image. In this case, the 
uncovered portion has the background color of the interface (see next paragraph). 
 
6.2.1.2.2. Background color 

The background color of the interface applies to the general background of the forms.  The 
current color is the one of the button associated to the background label in the Interface zone.  
The user can change this color by clicking on the button.  
 
If the user changes the background color of the interface, the neighbouring checkbox labelled 
Apply to all is emptied. If the user checks the box, the background color of the interface will 
also be used for the background of the rectangles, the buttons (push buttons, checkboxes, radio 
buttons and tabs) and the background of tables.  Then, the button associated to the Controls 
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label in the Controls and lines zone, and the button associated to the Background color label 
of the Tables zone will have the color of the button of the interface background.  
 
If the user modifies the color of the controls or of the table background, the checkbox Apply to 
all associated to the background color of the interface is emptied if it was checked.  
 
6.2.1.2.3. Text color 

The color of the interface texts applies to the texts in the windows except the group identifiers, 
the labels of buttons, the texts dynamically acquired by the application, the tooltips and the texts 
in the fields and cells of tables.  The current color of the interface texts is the one of the button 
associated to the texts label in the Interface zone.  The user can change this color by clicking 
on the button.  
 
If the user changes the color of the interface texts, the neighbouring checkbox labelled Apply to 
all is emptied.  If the user checks the box, the color of the interface texts will also be used for 
the group identifiers, the labels of push buttons and the texts dynamically acquired by the 
application. Then, the buttons associated to the Buttons, Dynamic and Groups labels of the 
Texts zone will have the color of the button of interface texts.  
 
If the user modifies the color of one of the elements of the Texts zone except Tooltips, the 
checkbox Apply to all associated to the color of the interface texts is emptied if it was checked.  
 
6.2.1.3. Fields and cells 

The buttons of the Fields and cells zone allow the user to define a color for the fields and cells 
of tables in the entry forms. The different fields and cells are: 

• Enabled: the fields and cells that can receive a value from the user 

• Disabled: the fields and cells that, in a given context, cannot receive a value from the user 

• Required: the fields and cells that must necessarily receive a value from the user 

• Calculated: the fields and cells that are usually not in the database, and whose value is the 
result of a calculation done by the application 

• Fixed: the fields and cells which contained a value resulting from a calculation done by the 
application but that was modified by the user 

• Active: the fields and cells whose content can be edited when the cursor is in them 
 
6.2.1.4. Controls and lines 

The buttons in the Controls and lines zone have the following roles:  

• Controls: This button is used to define the background color of the rectangles and buttons 
(push buttons, checkboxes, radio buttons and tabs) contained in the windows.   

• Light lines: This button is used to define the color of the pale lines used to limit an element 
in a window or to suggest its elevated or imbedded relief.  

• Dark lines: This button is used to define the color of the dark lines used to limit an element 
in a window or to suggest its elevated or imbedded relief. 

• Tooltips: This button is used to define the background color of the tooltips. 
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6.2.1.5. Texts 

The buttons of the Texts zone have the following roles: 

• Buttons: This button is used to define the color of the labels of the push buttons.  

However, the buttons used to call the drawing attributes editing window show the current 
drawing attributes for the graphic element involved.  

• Dynamic: This button is used to define the color of the values dynamically acquired by the 
application. They are written directly in the interface or in a rectangle, outside a field or a 
button. 

These texts are, for example, values read in a file or provided by the system and displayed 
on a purely informative basis. 

• Groups: This button is used to define the title color of groups of elements forming a zone, 
such as the “Interface” or “Fields and cells” strings in the editing window of the appearance 
of the entry forms.  

• Tooltips: This button is used to define the text color of the tooltips. 
 
6.2.1.6. Tables 

The controls of the Tables zone have the following roles: 

• Rulers color: This button is used to define the color of the limits of the cells in a table.  

• Background color: This button is used to define the background color of the tables 
contained in the forms (not the background color of the cells of the tables). 

• Display: The horizontal and vertical checkboxes are used to define if the horizontal and 
vertical limits of the cells in a table will be displayed or not.  
 

6.2.1.7. Conserving the defined parameters 

When the editing window for the appearance of entry forms is exited with OK, the values of 
these parameters are saved in the registry of the user’s workstation for the application.  When 
the application is used again, the entry forms will be displayed as the user previously defined 
them.  
 
6.2.2. Confirm before saving 

If the checkbox Confirm before saving is clicked, a message is displayed during navigation 
every time a modification is done to the data asking the user to save or not the modification. 
Otherwise, when navigating, the modified data is automatically saved in the database. 
 
6.2.3. Notify for missing fields 

If a field is not present in the database (due to changes in the database version, for example), a 
message will pop-up to inform you. 
 
6.2.4. Maximum field length for the display of lists 

The user can specify the maximum length of a field defined in the database to display lists.  
For example, if the user does not want lists displayed for descriptions of 255 characters, he can 
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set the value to 254.  After this value is modified, the user may have to exit and re-enter the 
application for the change to be applied.  
 

 

Figure 6-12 - Default panel of the preference editing window 
 
6.2.5. Customized format 

The configuration of all Geotec forms is saved automatically in the tables REPORT and 
REPORT_COL. The original format provided by Geotec is the Default format, saved with the 
name FORM_DEF.  
 
If you want to create a specific format, enter a new name in the field Customised format name. 
This name will be added to the list and available to all users of the current database. This format 
is saved under the name FORM_DEF_name. 
 
When a modification is done by the user (ex: move or resize a column, hide a field, change the 
number format, etc.) it is saved in the selected format. 
 
If the box Custom description of the fields is checked, the tooltips will display the values of 
the DESCRIPTION field defined in the REPORT_COL table for each table, for the selected 
format. These descriptions are provided when the database is first opened in the current 
language used but can be modified.  
 
If the box isn’t checked, the tooltips will display the field descriptions provided by Geotec in the 
current language used. 
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6.2.6. Appendix number 

The expression in the Appendix number field provides the value of the $$APPENDIX keyword. 
 
6.2.7. Figure number 

The expression in the Figure number field provides the value of the $$FIGURE keyword. 
 
6.2.8. Missing value 

The expression in the Missing value field provides the value of the $$NIL keyword.  The 
application also uses this expression to identify missing values that are not managed by the 
equivalences, particularly in tables. 
 
6.2.9. Text editor 

To view style, markers or patterns files, the user can select the executable of a text editor.  If the 
field stays empty, the X3D default text editor will be used.  
 
6.2.10. Default drawing attributes 

When an application using X3D is first used, minimal drawing attributes are defined by default 
for the graphic entities that will be created.  These basic default attributes are:  

• Texts in black with 2.82 mm characters (size 8) using the normal Arial font; 

• Solid black lines of 0.1 mm thickness; 

• No filling, no marker and no pattern. 
 
These attributes will remain the default attributes as long as they are not modified.  The default 
attributes established when the application is closed are saved in the work environment of the 
application for the next use.  
 
Modifying the default drawing attributes does not change the drawing attributes of the entities, 
graphs or objects already defined in the page.  It will be possible to use these default drawing 
attributes for graphic objects by clicking on the Default button in their attributes window (see 
chapter 9). 
 
To modify the default drawing attributes, click on the button labelled Text at the bottom of the 
window.  If the drawing attributes configuration window is opened in this context, clicking on the 
Default button brings back the drawing attributes to the basic values defined above. 
 

6.3. File panel 

This panel is used to define the default directories for the input and output files, as well as the 
logo file and the text editor to use to view files. 
 
6.3.1. Input files 

It is possible to define a default directory for all the input data files. The file selection window will 
open on this directory by default, except for databases, style files, markers and patterns files, in 
which case the selection window opens on the directory of the current file.   
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The user can select the directory of the input files by clicking on this button .  The user can 
also use the directory of the database by clicking on the radio button corresponding to this 
choice.  
 
By checking the box Save file name with path, the complete path of the file is saved when the 
user selects a file in a Windows file opening window, for any file field in the database (ex: 
PHOTO_NO in BORING or in TRENCH). Otherwise, only the file name is saved, and it is 
assumed that it is located in the input files directory.  
 
6.3.2. Output files 

For output files, the same logic applies as for the input files. The output files are saved in the 
selected directory.    
 

 

Figure 6-13 - File panel of the preference editing window 
 
6.3.3. Marker file 

The user can choose a markers file to use with the current style file by selecting the file with the 

 button and by checking the box Use with current style file. This information is saved in the 
style file.  Otherwise, the current markers file is used.  
 
6.3.4. Pattern file 

The user can choose a patterns file to use with the current style file by selecting the file with the 

 button and by checking the box Use with current style file. This information is saved in the 
style file. Otherwise, the current patterns file is used. 
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6.3.5. Logo file 

The selection of a logo file changes the figure associated to the image type object defined with 
the $$LOGO keyword. The logo files are image files such as .bmp, .gif, etc. 
 
 

7. OPTIONS 

The Tools menu has the Options item (or the button shown here, located in the application 
toolbar), which opens a window specific to each module. The options window is described in the 
documentation of each module.  
 
 

8. MARKERS 

8.1. Marker editor 

Selecting the Markers option or clicking on the button shown on the left opens the marker 
editing window on the current .mrk markers file and activates a reduced version of the graphic 
editing toolbar and the File menu, as shown in figure 6-14. 
 
With this editor, the user can modify the appearance of the markers defined in the current .mrk 
markers file, whose name and path are written in the File field of the window.  The main part of 
the editor is the editing section where the selected marker is displayed.  In the section, the 
dashed square represents one mm2 in the graphic page. 
 

8.2. Management of the markers file 

8.2.1. Selecting the current markers file 

When an application using X3D is launched, the last markers file used is loaded as the current 
markers file. 
 
Before opening the marker editor, it is possible to change the current file by selecting a file from 
the Recent Markers option in the File menu. 
 
In the marker editor, a markers file can be selected from the scrolling list associated to the File 
field.  This list shows the last 9 markers files used (role equivalent to the Recent Markers option 
of the File menu). 
 
The user can also change the markers file by selecting the Open… option of the File menu, by 
clicking the button shown here located in the graphic editing toolbar or by clicking on Browse in 
the editor, which opens the standard window for file selection on the directory of the current file.  
The proposed extension is .mrk. 
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Figure 6-14 - Marker editor, graphic editing toolbar and File menu 
 
8.2.2. Saving the markers file 

The current markers file is updated when the user exits the editor by clicking OK. It is not 
updated if he clicks Cancel or the X of the editor. If the user changes the marker when the 
current marker was modified, a message is displayed to ask if the modified marker should be 
saved or not.   
 
It is always possible to save the markers file being edited by selecting the Save option of the 
File menu or clicking on the button shown on the left.  When the marker editor is opened, 
selecting the Save As… option of the File menu opens the standard window for file saving 
where the user can define a new path and / or a new name for the markers file in memory, 
which then becomes the current markers file. 
 
It is also possible to exit the marker editor with the Close and Quit options of the File menu. 
The first option cancels the changes made in the editor, while the second saves them.  
 
8.2.3. Viewing the markers file 

When the marker editor is open, select the View option of the File menu to display the content 
of the current markers file in the text editor selected in the preferences.  
 

8.3. Current marker – selecting a marker 

When a markers file is opened for the first time during a work session, the 1st marker in the file 
is displayed. The next times during the same work session, the last selected or edited marker 
will be displayed.  
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To select another marker:  

• Display the scrolling list associated to the # field and select the number of the desired 
marker; 

• Click on the Select button, which opens the palette of markers defined in the current 
markers file, as shown in figure 6-15. 

 

 

Figure 6-15 - Palette of markers 
 
The current marker is identified by “handles” on its border.  When the cursor of the mouse 
moves on the selection palette, the identification of the marker on which the cursor is placed is 
shown in the status bar, including its number, name and title.  
  
The user can zoom on the palette of markers via the Full Page, Full Width, 50%, 100% (default 
value), 200% and Other… options of the View menu. 
 
To select another marker, click in the square in which it is represented, and close the window.  
The selected marker is then displayed in the preview area of the marker editing window.  Its 
number, name and title appear in the fields at the top of the editor.  These values are 
modifiable.  However, the user will not be able to give a marker a number that already exists in 
the markers file.  
 

8.4. Creating a marker 

To create a new marker, open the marker selection palette by clicking on Select, move to the 
bottom of the palette and select the empty square that appears after all the existing markers. 
The number proposed by default for the new marker is 1 greater than the highest number 
already saved in the markers file.  The user then adds the components of the marker as detailed 
in paragraph 8.6. 
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8.5. Deleting a marker 

The Delete button deletes the selected marker from the current markers file.  The marker 
disappears from the palette but its number is not reallocated to another marker.  
 

8.6. Editing a marker 

As indicated in paragraph 8.1, a reduced version of the graphic editing toolbar is activated in the 
marker editor. The user can add objects to the current marker.  These objects and the other 
options of the toolbar are described in chapter 4 of the X3D guide. The editing is done the same 
way as the insertion and modification of graphic objects in the page.  
 

8.7. Printing a marker 

The Print option of the File menu is not functional in the current version.  
 
 

9. PATTERNS 

9.1. Pattern editor 

Selecting the Patterns option or clicking on the button shown on the left opens the pattern 
editing window on the current .ptn patterns file and activates a reduced version of the graphic 
editing toolbar and the File menu, as shown in figure 6-16. 
 
With this editor, the user can modify the appearance of the patterns defined in the current .ptn 
patterns file, whose name and path are written in the File field of the window.  A pattern can be 
made up of 3 types of different superimposed elements: 

• Grains, in one or many layers; 

• Hatchings, in one or many layers; 

• Objects or graphic shapes, in only one layer. 
 

9.2. Management of the patterns file 

9.2.1. Selecting the current patterns file 

When an application using X3D is launched, the last patterns file used is loaded as the current 
patterns file. 
 
Before opening the pattern editor, it is possible to change the current file by selecting a file from 
the Recent Patterns option in the File menu. 
 
In the pattern editor, a patterns file can be selected from the scrolling list associated to the File 
field.  This list shows the last 9 patterns files used (role equivalent to the Recent Patterns 
option of the File menu). 
 
The user can also change the patterns file by selecting the Open… option of the File menu, by 
clicking the button shown here located in the graphic editing toolbar or by clicking on Browse in 
the editor, which opens the standard window for file selection on the directory of the current file.  
The proposed extension is .ptn. 
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Figure 6-16 - Pattern editor, graphic editing toolbar and File menu 
 
9.2.2. Saving the patterns file 

The current patterns file is updated when the user exits the editor by clicking OK. It is not 
updated if he clicks Cancel or the X of the editor. If the user changes the pattern when the 
current pattern was modified, a message is displayed to ask if the modified pattern should be 
saved or not.   
 
It is always possible to save the patterns file being edited by selecting the Save option of the 
File menu or clicking on the button shown on the left.  When the pattern editor is opened, 
selecting the Save As… option of the File menu opens the standard window for file saving 
where the user can define a new path and / or a new name for the patterns file in memory, 
which then becomes the current patterns file. 
 
It is also possible to exit the pattern editor with the Close and Quit options of the File menu. 
The first option cancels the changes made in the editor, while the second saves them.  
 
9.2.3. Viewing the patterns file 

When the pattern editor is open, select the View option of the File menu to display the content 
of the current patterns file in the text editor selected in the preferences. 
 

9.3. Current pattern – selecting a pattern 

When a patterns file is opened for the first time during a work session, the 1st pattern in the file 
is displayed. The next times during the same work session, the last selected or edited pattern 
will be displayed.  
 
To select another pattern:  

• Display the scrolling list associated to the # field and select the number of the desired 
pattern; 
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• Click on the Select button, which opens the palette of patterns defined in the current 
patterns file, as shown in figure 6-17. 

 

 

Figure 6-17 - Palette of patterns 
 
The current pattern is identified by “handles” on its border.  When the cursor of the mouse 
moves on the selection palette, the identification of the pattern on which the cursor is placed is 
shown in the status bar, including its number, name and title.  
  
The user can zoom on the palette of patterns via the Full Page, Full Width, 50%, 100% (default 
value), 200% and Other… options of the View menu. 
 
To select another pattern, click in the square in which it is represented, and close the window.  
The selected pattern is then displayed in the preview area of the pattern editing window, right of 
the All panel.  Its number, name and title appear in the fields at the top of the editor.  These 
values are modifiable.  However, the user will not be able to give a pattern a number that 
already exists in the patterns file.  
 

9.4. Creating a pattern 

To create a new pattern, open the pattern selection palette by clicking on Select, move to the 
bottom of the palette and select the empty square that appears after all the existing patterns. 
The number proposed by default for the new pattern is 1 greater than the highest number 
already saved in the patterns file.  The user then adds the components of the pattern as detailed 
in paragraph 9.6. 
 

9.5. Deleting a pattern 

The Delete button deletes the selected pattern from the current patterns file.  The pattern 
disappears from the palette but its number is not reallocated to another pattern.  
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9.6. Editing a pattern 

As indicated in paragraph 9.1, a pattern is made up of 3 different types of elements. With the 
Grains, Hatching and Objects tabs, the user accesses the panels of the elements for editing.  
The panel opened with the All tab shows the entire pattern in the proportions it will have in the 
graphic objects. 
 
In the Grains, Hatching and Objects panels, the zone at the right of the window is an editing 
zone where the grains, hatching and simple graphic entities will be drawn.  This zone is 
repeated in the entire area occupied by the graphic object to which the pattern applies.  
 
9.6.1. Editing the grains 

By clicking the Grains tab, the editing panel for the grains is displayed, as shown in figure 6-18.  
The user can edit the different layers of grains that are superimposed.  
 

 

Figure 6-18 - Editing panel for the grains of a pattern 
 
The selection of the layer to edit is done in the scrolling list associated to the Layer field. 
Clicking on the New button creates a new layer of grains, whose number is added to the 
numbers of the existing layers. When a new layer of grains is created, it has default values for 
its geometry, its dimensions, etc.  Clicking on the Remove button deletes the current layer of 
grains, and the numbers of the layers are readjusted.  
 
For each layer of grains, the user specifies the size of the grains and their minimum and 
maximum spacing, as well as their geometry.  All dimensions are in millimeters. Identical 
minimum and maximum spacing mean that the layer has equidistant grains; otherwise, the 
grains are generated at random distances from each other, but without exceeding the fixed 
spacing limits.  
 
The possible geometry for the grains is: round; rectangle; triangle; cobble. With the “cobble” 
geometry, each grain takes a semi-circular shape whose diameter varies randomly between the 
value in Grain size and half this value. 
 
The user can modify the drawing attributes of the layer of grains with the button shown here, 
located in the graphic editing toolbar.  
 
The buttons in the middle of the panel are used to copy and paste respectively a layer of grains. 
The “paste” button becomes active when a layer is copied in memory.  
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9.6.2. Editing the hatchings 

As for the grains, a pattern can have different layers of hatchings that are superimposed.  By 
clicking on the Hatching tab, the editing panel for the hatchings is displayed, as shown in figure 
6-19. 
 
The selection, creation and deletion of a layer of hatchings are done as for the grains. 
 
For each layer of hatchings, the user specifies the line spacing, the offset from the origin and 
the angle of the lines with the horizontal.  The line spacing and the offset are measured 
perpendicularly to the lines. The offset is the distance between the origin and the first line of 
hatchings.  Depending on the orientation of the hatchings, the origin is: 

• the bottom line of the tile (horizontal hatchings) 

• the right side of the tile (vertical hatchings) 

• the lower left corner of the tile (hatchings with an angle to the horizontal between 90o and 
180o exclusively) 

• the lower right corner of the tile (hatchings with an angle to the horizontal between 0o and 
90o exclusively) 

 

 

Figure 6-19 - Editing panel for the hatchings of a pattern 
 
The user can modify the drawing attributes of the layer of hatchings with the button shown here, 
located in the graphic editing toolbar.  
 
The buttons in the middle of the panel are used to copy and paste respectively a layer of 
hatchings. The “paste” button becomes active when a layer is copied in memory.  
 
9.6.3. Editing the graphic shapes 

The last component of a pattern can be a layer of graphic shapes.  By clicking on the Objects 
tab, the editing panel for the graphic shapes is displayed, as shown in figure 6-20. 
 
The buttons of the reduced version of the graphic editing toolbar are then active. The user can 
add graphic shapes to the layer of the current pattern.  These graphic objects and the other 
options of the toolbar are described in chapter 4 of the X3D guide. The editing is done the same 
way as the insertion and modification of graphic objects in the page. 
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In this panel, the dX and dY fields are used to define the dimensions of the dashed square in 
the editing zone, in millimeters.  This square will be repeated in the entire area occupied by the 
graphic object to which the pattern applies. 
 

 

Figure 6-20 - Editing panel for the graphic shapes of a pattern 
 
9.6.4. Copying an entire pattern 

In the All panel, the “copy” button stores in memory all the layers of the pattern.  In a new 
pattern, if we click on “paste”, all the layers in memory are pasted in this new pattern. However, 
if the user goes in the Grains or Hatching panel of a new pattern, clicking on “paste” introduces 
only the layer of grains or hatchings that was current at the time of the copy. 
 

9.7. Printing a pattern 

The Print option of the File menu is not functional in the current version.  
 
 

10. OBJECTS 

The graphic editing mode is opened via the Objects option of the Tools menu or this button 
located in the X3D toolbar.  The Object mode remains active until the user closes it by clicking 
again on Objects in the Tools menu or on this button which is located at the bottom of the 
graphic editing toolbar.  Chapter 4 of the X3D guide describes the Object mode.  
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CHAPTER 7. DATA MENU 

The Data menu is shown in figure 7-1. In general, this menu has two groups of options:  

• The first group is used for the management of data specific to the current application.  It 
contains the Retrieval by…, Record and Entry… options.  

• The second group includes the utilities.  It contains the Open Table…, Data Sheets…, 
Report… and Import File… options. 

 

 

Figure 7-1 - Data menu 
  
 

1. CONNECTION TO A DATABASE 

Before managing the data specific to a database, the user must connect to one of them.  For all 
applications using X3D and a database, the connection is done directly when calling the 
application, or via the Open Database or Connect Database option of the File menu.  
 
If an option of the Data menu is chosen before a database is connected, the connection window 
will be displayed.  See chapter 2 for all the details about the connection to a database.  
 
 

2. GEOTECHNICAL DATA MANGEMENT 

The management of the data from the connected database is done in the various modules. The 
user can insert, modify or delete information from the database which will be reflected in the 
other modules of Geotec. See the Geo guide for data entry forms 
 
 

3. DATA RETRIEVAL 

The Retrieval by… option opens a sub-menu with five options: Simply Query, Customized 
Query, Google Map, Polygonal Limit and Group of Records, as shown in figure 7-2.  These 
options are used to execute different types of queries to find the desired data.  
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Figure 7-2 - Sub-menu of the “Retrieval by” option 
 

3.1. Simple Query 

To do a simple query, choose the Simple Query option, this button located in the application 
toolbar, or press [F7] in the main window.  The entry form opened by default depends on the 
application and the type of data to retrieve for graphic display.  
 
When opened, the entry form will be in “Query mode”, visible by the title and blue background of 
the entry form (figure 7-3). The user can enter a query in any field of any entry form.  Enter the 
desired value in the field or choose the value in the data list which shows all the values in the 
database for this field.  Each list also shows an “is NULL” item to retrieve all records with no 
value in the current field. 
 
By using the [F7] key a second time, the conditions of the last query are called.  The Last option 
of the Query menu has the same role. 
 

 

Figure 7-3 - Entry form for Boring in “Simple query” mode 
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3.1.1. Search characters 

It is possible to use the “%” or “_” characters to search.  “%”is used to replace several 
characters when doing the search.  For example, if the user wants to do a query for all borings 
starting with T, he will write “T%” in the Boring field.  “_” replaces a single letter or a single 
number in the value when doing the search.  If the user wants to do a query for all borings 
between 90 and 99, he will write “9_”. 
 
3.1.2. Excluding records 

It is possible to exclude records from the query, by using the “!” character, corresponding to “not 
LIKE”. The “!” can be used for a precise value, or with replacement characters.   
 
Example:  !TP% to return everything except borings starting with TP.  
Example:  !%2015% to return everything except boring with the value 2015 in their number.  
 
3.1.3. Selection of multiple records 

In query mode, you can select more than one value of a list.  Hold down the [Ctrl] key and click 
on the desired values for non-consecutive values or use the [Shift] key for consecutive values, 
by clicking on the first and last value of the series. Then click on [Enter] when the selection is 
done. All values will then be displayed, separated by « ; ». 
 
The multiple selections can also include exclusions, by separating them with « ; ». 
 
Example:  !TP%;!%2014% to exclude records starting with TP and records with 2014 in their 
number. 
 
3.1.4. Numerical values and dates 

It is also possible to execute queries on numerical values and dates. Use < or > to find records 
smaller or greater than a certain value or date. The date must be complete (ex: >2015-05-15) 
 
3.1.5. Executing the query 

To execute the query, the user can use the [F8] key, this button located in the toolbar of the 
entry forms, or the Execute option of the Query menu. 
 

3.2. Customized Query 

Please note: the customized queries are less common and more complicated than the simple 
queries.  
 
To do a customized query, choose the Customized Query option of the Retrieval by sub-menu 
of the Data menu, or this button located in the application toolbar.  The query editing window is 
shown in figure 7-4.   
 
When the customized query editing window is first opened, the conditions displayed are the 
default ones, specific to the application. The values entered are those of the last query, be it 
simple or customized.   
 
Most of the window consists of a table where each line represents one of the data retrieval 
conditions.   
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In the top zone labelled Query, the controls allow the user to save in the database the group of 
conditions under a given name.  In this zone, the user can also select a group of conditions 
already saved (see paragraph 3.2.11). The user can also delete a group of conditions. 
 

 

Figure 7-4 - Definition window for a customized query 
 
3.2.1. Creation of a condition 

The creation of a condition is done in an empty row of the conditions table.  The addition of a 
condition creates a new row in the conditions table. 
 
3.2.1.1. Selective condition 

By selective condition, we refer to a condition that has a chosen criterion in all its elements, with 
the eventual exception of Null.  To create a selective condition, the steps are:  

• Select a table from the database by clicking in the cell of the Table column, which displays 
the call button for scrolling lists to the right of all cells in the row of the condition, and by 
selecting the table in the scrolling list (see figure 7-5) or directly typing its name in the cell. 
Selecting a table may automatically create join conditions (see paragraph 3.2.6). 

• Select a field of the table in the cell of the Field column. This selection is done the same 
way as for the table; the scrolling list displays the fields from the selected table. 

• Select an operator in the cell of the Operator column. This selection is done the same way 
as for the table and field.  Figure 7-6 shows the scrolling list of the operators.  

With the “Like” and “Not Like” operators, the “%” and “_” characters can be used in the 
value as a replacement character, as in a simple query (see paragraph 3.1). Do not confuse 
the “==” operator which is a join operator between two tables and the “=” operator which is 
the equality operator.  
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Figure 7-5 - Example of a scrolling list of tables 
 

 

Figure 7-6 - Scrolling list of the conditions operators 

• Select one or many values, accordingly, in the cell of the Value column.  This selection is 
done the same way as for the table, field or operator.  If the operator is “=”, “Like” or “Not 
Like”, it is possible to choose several values, the separation character being “;”. 

The scrolling list will allow selecting one or many values, depending on the operator.  Hold 
down the [Ctrl] key and click on the desired values for non-consecutive values or use the 
[Shift] key for consecutive values, by clicking on the first and last value of the series.  

The list of the possible values in a condition depends on all other conditions defined in the 
table.   

• Ask to retrieve the records that do not have a value in the field of the condition, by entering 
Y or N in the cell of the Null column.  If the field chosen in the condition is not with required 
value, the Null cell contains N by default.   

In some cases, the user may want to retrieve the records with no value in a field, in addition 
to the records with the chosen value for this field.  For example, since borings are generally 
vertical, the DIP field will often contain no value, sometimes 90, and a value lower than 90 if 
the boring is not vertical.  To retrieve only the vertical borings, the condition should be that 
the DIP field of the BORING table is equal to 90 degrees or empty, so with Y in the Null cell. 

For example, if the condition is on the CATEGORY field of the GRAIN_SIZE table with “Not 
Like” as the operator and «EX» as the value, the query will return all the records with a value 
other than EX in the CATEGORY field of the GRAIN_SIZE table. The records with no value 
in this field will only be retrieved if the condition contains Y in the Null cell. 
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3.2.1.2. Non-selective condition 

A non-selective condition has one or many elements with no defined criterion.  The following 
examples using the Log module describe the purpose of a non-selective condition:  

• If the user wants to retrieve the borings having a dip value entered in the database, 
whatever the value, and exclude the borings without a dip value, he creates a condition on 
the DIP field of the BORING table using the “<>” operator, an impossible value, 370 for 
example, and N in the Null cell.  

• If the user wants to retrieve all the borings in which a piezometer is defined, he creates a 
condition in which he only selects the PIEZOMETER table and leaves empty the other 
elements of the condition.  This condition is interpreted as a retrieval of the records of 
borings present in the PIEZOMETER table, without another specification. 
 

3.2.2. Modification of a condition 

Modifying a condition is done by selecting a new element of this condition, the table, field, 
operator, value or presence of records with the empty field.  
 
The lists of the possible values in a condition always take into account the other conditions of 
the table.  
 
Changing an element in a condition erases all the elements in the cells to the right of the 
modified element.  Therefore, changing the name of the table in a condition implies selecting a 
field from this table as well as the other elements of the condition. 
 
Modifying a condition may lead to the deletion and/or addition of join conditions (see paragraph 
3.2.6). 
 
3.2.3. Deletion of a condition 

To select or unselect a condition, click in the grey cell on its left.  A condition is selected when it 
is in reverse video.  The Delete, Previous and Next buttons are then active.  To delete a 
condition, select it and click on Delete.  
 
Deleting a condition may lead to the deletion of join conditions (see paragraph 3.2.6). 

 
3.2.4. Insertion of a condition 

Clicking on the Insert button inserts a new empty row in the conditions table.  The new row is 
inserted at the top of the table if no condition was selected, or after the selected row.  The user 
can then create a condition in the new row. 
 
3.2.5. Moving a condition 

The user can move a condition in the table by selecting it and clicking on one of the buttons with 
an up and down red arrow, to move the condition up or down by one row in the table. 
 
3.2.6. Join conditions 

3.2.6.1. Automatic join conditions 
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The following example defines a join condition, more specifically an automatic junction 
condition. 
 
To select all the borings from the “SMALL_DAM” site that have a piezometer, the user creates a 
condition on the SITE_NO field of the BORING table using the “=” or “Like” operator and the 
“SMALL_DAM” value.  He then creates a new condition whose only criterion is the 
PIEZOMETER table.  By selecting this table, the two join conditions illustrated in figure 7-7 are 
automatically created. 
 

 

Figure 7-7 - Example of automatic join conditions 
 
These conditions mean that the application must locate all the borings identified by the pair 
SITE_NO - BORING_NO present in the BORING and PIEZOMETER tables. 
 
For join conditions to be created automatically there must be a relationship between the tables 
of the conditions.  In the previous example, the SITE_NO and BORING_NO fields in the 
PIEZOMETER table are not only part of the key of the PIEZOMETER table but also form an 
external key that links the PIEZOMETER table to the BORING table.  
 
The elements of an automatically generated join condition cannot be modified but the condition 
can be deleted.  This deletion may make the condition at the origin of the deleted join condition 
unnecessary (without any effect). 
 
3.2.6.2. Join conditions entered by the user 

This example explains when the user should create a join condition to specify the retrieval. 
 
If the user wants to retrieve the borings that have the same category as at least one of their 
respective samples, he must create the join condition shown in figure 7-8. 
 

 

Figure 7-8 - Example of a join condition entered by the user 
 
To create this join condition, the user creates a new condition on the table and field to compare, 
SAMPLE and CATEGORY in our example. He then selects the “==” operator. Choosing the 
value, “BORING.CATEGORY” in our example, is done via the scrolling list of the Value cell, as 
shown in figure 7-9. The user then simply clicks the desired value. 
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Figure 7-9 - Scrolling list of values in a join condition 
 
3.2.7. Viewing the SQL command 

Clicking on the SQL button opens a tool tip, shown in figure 7-10. The SQL command displayed 
is either the one used to build the scrolling list of values valid for the selected condition, or the 
one reflecting all the conditions if no condition is selected.   
 

 

Figure 7-10 - Example of an SQL command 
 
3.2.8. Default conditions 

Each application has specific default conditions.  Selecting the Default value from the scrolling 
list associated to the Name field in the Query zone (see paragraph 3.2.11) replaces the content 
of the table with the default conditions of the application. The values entered as criteria for these 
conditions are the last values used. 
 
For example, with Log, the default conditions are on the SITE_NO and BORING_NO fields of 
the BORING table. 
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3.2.9. Predefined conditions 

Conditions on the domain in which the borings must be located can be established. 
 
The Domain button at the top of the editing window of customized queries opens a window in 
which the domain for the retrieval of borings can be defined. It is an alternative to the queries by 
polygonal limit (see paragraph 3.4). The window shown in figure 7-11 is then opened.  
 
The two panels designated by Current and Previous are identical. The Current tab shows the 
values of the current defined domain, while the Previous tab shows the last values defined in 
the window.  

 

Figure 7-11 - Domain definition window 
 
The values in the domain window are defined as:  

• The zone in which the domain is located. 

• The orientation of the domain, i.e. the angle between the edges of the domain and the 
cardinal directions (Angle);  

The normal orientation is 0. The angle increases positively when turning in counter 
clockwise direction from the normal orientation, and negatively in the other direction.  

• The coordinates of the origin of the domain (X Origin and Y Origin); this origin is located at 
the bottom left corner of the domain;  

• The size of the domain (Width and Height);  

• The minimum and maximum elevations of the top and bottom of the borings (Z Min and Z 
Max). 

 
After clicking OK, the conditions on the domain are found in the table of the conditions in the 
editing window for the queries, as shown in figure 7-12. 
 

 

Figure 7-12 - Conditions on the domain 
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3.2.10. Launch / cancellation of the query 

To launch the data retrieval, click OK in the query editing window or press the [F8] key. The 
data found are then displayed in the graphs and objects defined in the style file used. Clicking 
on Cancel closes the query editing window without launching the data retrieval. 
 
3.2.11. Management of queries 

The user can save a query in the database, i.e. the group of established conditions (see the 
description of the QUERY_NAME and QUERY_CONDITION tables in the guide of the entry 
forms).  A previously saved query can be selected, modified and deleted. 
 
The controls used for the management of the queries are in the rectangle labelled “Query” in the 
editing window of the customized queries (see figure 7-4). 
 
3.2.11.1. Selecting a query 

To select a query in the database, click on the arrow button right of the query name field.  In this 
list, the “Default” term is displayed first, followed by the saved queries in alphabetical order.  
 
To choose a query from the list, click on its name. Then, the name of the selected query, its 
description and its conditions are displayed in the fields and table of the conditions editing 
window. 
 
3.2.11.2. Saving a query 

To be able to save the current query in the database, the Add button must be active.  
 
For the Add button to be active, the name of the query must be different than “Default”, at least 
one of its conditions must have changed, its description must have been edited, or its name 
must have changed.  Thus, if the user selects a query without changing its conditions, 
description or name, it is not possible to save the query. 
 
To save the current query, click Add.  If the name of the query already exists, it will be updated 
in the database.  If the name of the query does not exist in the database, its definition and 
conditions will be added.  It is not possible to modify the “Default” query. 
 
The name of the query is entered in the Name field of the Query zone.  If a query is selected, 
the user can change its name.  If the user provides a query name that already exists in the 
database, a message will notify the user and he must enter another one.   
 
The Description field is used to enter a string of up to 255 characters to describe the query. It 
becomes active when a name other than Default is used. The button on the right of the 
Description field opens the text editing window. 
 
3.2.11.3. Deleting a query 

To delete a query, select it and click on the Remove button of the Query zone.  The Remove 
button is not active for the Default query. 
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3.3. Google Map 

The Google Map option of the Retrieval by sub-menu of the Data menu opens the window 
shown in figure 7-13. This window is used to display the location of borings, sites and regions, 
(and axes and limits via Pro and Site) in Google Map.  
 
Once data are retrieved, place the cursor on an entity and Google Map will display a tooltip with 
information about the entity. For borings, information includes the site and boring numbers, type, 
state, zone, northing, easting, elevation, rock depth, maximum depth, latitude and longitude. For 
sites and regions, information includes the site or region number, the zone, and the latitude and 
longitude of the site or region center.  
 

 

Figure 7-13 - Google Map 
 
3.3.1. Location 

The longitudes and latitudes of the geotechnical entities (borings, sites, regions) must be 
entered or calculated in the database in order to see them on Google Map. See corresponding 
paragraphs of chapter 2 of the Geo guide for all details about the calculations. 
 
The latitude and longitude of the map center are shown. The user can modify the center 
manually or by moving the map using the mouse. 
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The current zoom can be manually set or modified with the scroller of the mouse. The greater 
the zoom number, the greater the close-up. 
 
It is possible to recenter the map on a site from the database. The list shows all sites whose 
longitude and latitude have been inputted or calculated. 
 
3.3.2. Map type 

The typical options for display are available: Roadmap, terrain, satellite and hybrid. 
 
The color attributes for the regions, sites and borings inside domain can be set differently for the 
satellite and hybrid modes. See paragraph 3.3.4. 
 
3.3.3. Entities to display 

The user can define the zoom level for each type of entity.  
 
Under the marker, the user defines the zoom above which a marker will be shown for each 
region, site or boring in the map domain. In the example below, if the current zoom is 8 or 
smaller, the borings and the sites will not be displayed. 
 
Under the text BH-01, the user defines the zoom above which the entity number will be shown 
for each region, site or boring in the map domain. In the example below, if the current zoom is 9 
or 10, the sites will be shown as markers but without their identification, and the borings will not 
be displayed. 
 
3.3.4. Displayed data 

Each of the five buttons opens the Attributes editing window.  

• Regions and Sites: a marker and its diameter can be defined, as well as the font, its size 
and the text alignment. With roadmap and terrain, the marker and text are black. With 
satellite and hybrid, another color can be defined for the marker, which will also be used for 
the text.  

• Borings: the marker used for each boring is the one in the current markers file whose name 
is the concatenation of the type and state of the boring, for example, TP_R for a realized test 
pit. If no corresponding marker is found, the one defined for borings is used. The marker 
and its diameter can be defined, as well as the font, its size and the text alignment.  

 The current boring is always red (marker and text). It is the first boring from the query 
and shown in the graphic page. 

 The retrieved borings are always blue (marker and text). They are the borings 
retrieved in the query other than the current one. 

 The borings inside the domain include all borings located in the domain of the map 
and visible at the current zoom. The number includes the current and the retrieved 
borings. With roadmap and terrain, the marker and text are black. With satellite and 
hybrid, the color defined for the marker Borings will be used for the marker and text. 

• Axes and Limit: the limit associated to the current site or surrounding all data is shown, as 
well as the axis retrieved if the query is done via the Pro module. The default attributes are 
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the same as the Axis_Curve and the Limit curves of the plan view but can be modified for 
Google Map. 

 
3.3.5. Interactive editing 

In Google Map, the user can right click to display the contextual menu shown in Figure 7-14.  
 

 

Figure 7-14 - Interactive menu in Google Map 
 
3.3.5.1. Creating a site 

By selecting Create Site, the cursor takes this format: . If the user wants to cancel right away, 
right click and select Cancel.  To create the site, left click at one corner of the new site, hold 
down and move the cursor to the diagonally opposite corner; a dotted line shows the area 
created. When the button of the mouse is released, the site entry form is displayed.  
 
By default, the MTM and NAD83 systems are used. The X and Y coordinates of the bottom left 
corner, its longitude and latitude, the zone used for the calculation, as well as the width and 
height of the area are automatically entered. If Google Map is displayed in background, the 
zone is determined from there. Otherwise, the zone used is the site’s zone previously displayed.  
 
The user then enters the site number and any other information in the entry form, and saves the 
new site.  
 
3.3.5.2. Creating an axis 

By selecting Create Axis, the cursor takes this format: . Left click at each point of the axis. A 
dotted line shows the movement of the cursor. When the last point of the axis is defined, right 
click to display the pop-up menu and select Cancel to erase the axis being created, or 
Terminate to edit and save the new axis. The axis entry form is then displayed and shows the 
coordinates of each point clicked. The user can then enter the axis number and any relevant 
information in the entry form, and save.   

 
3.3.5.3. Creating a boring 
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By selecting Create a Boring, the cursor takes this format: . Left click at the location of the 
boring. The boring entry form is then displayed and shows the coordinates of the added boring. 
The user enters the boring number and any relevant information in the entry form, and saves. 
 
3.3.5.4. Selecting borings 

By clicking Select Borings, the cursor takes this format: . Click and drag a rectangle 
containing the desired borings. The borings selected are then displayed in blue. The user may 
also select or unselect borings by pressing the [Ctrl] key and clicking on the desired borings.  
 
When all desired borings are selected, right click to display the menu shown in figure 7-15. The 
option Create a Group of Borings will open the selection entry form; each boring selected is 
identified with its site and boring number.  A selection number corresponding to the current 
boring number is displayed by default, and can be modified. The user then enters any other 
information in the entry form, and saves the new group of borings.  
 
With the option Delete these Borings, all borings selected and whose state is Planned will be 
deleted, after confirming the message displayed.  Records for borings of another state cannot 
be deleted this way. 
 

 

Figure 7-15 - Selection of borings 
 
3.3.5.5. Creating and modifying a rectangular limit 

By selecting Create Rectangular Limit, the cursor takes this format: . If the user wants to 
cancel right away, right click and select Cancel.  Left click at one corner of the rectangular limit, 
hold down and move the cursor to the diagonally opposite corner; a dotted line shows the area 
created. When the button of the mouse is released, the limit entry form is displayed; the X and Y 
coordinates of the four corners of the limit are automatically entered. The current site number is 
displayed as reference site. The user enters the limit number and any other information, and 
saves the new rectangular limit. 
 
3.3.5.6. Creating and modifying a polygonal limit 

By selecting Create Polygonal Limit, the cursor takes this format: . If the user wants to 
cancel right away, right click and select Cancel.  Left click at each point of the polygonal limit. A 
dotted line shows the movement of the cursor. When the last point of the polygonal limit is 
defined, right click to display the pop-up menu and select Terminate. The limit entry form is 
then displayed; the X and Y coordinates of all points of the limit are automatically entered. The 
current site number is displayed as reference site. The user enters the limit number and any 
other information, and saves the new polygonal limit.  

 
Any rectangular or polygonal limit can be modified with the mouse. When the cursor is on a 

limit, it takes this format: . By right clicking, a contextual menu is displayed.  
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When adding a point to the limit, the cursor becomes . The point will be added between the 
two closest points to the cursor. A message is displayed, showing the exact coordinates of the 
point. To stop the addition of points, right click and select Terminate.  
 
When the cursor is over a point of the limit, the option Delete this Point from Limit is active. A 
message is displayed to confirm the deletion of the point.   
 

When the cursor is on a point of the limit, it takes this format: . By clicking on the point, it 

takes the format . Move the point to the desired position, and release the button of the 
mouse; a message is displayed to confirm the move.  
 

3.4. Polygonal Limit 

Select the Polygonal Limit option of the Retrieval by… sub-menu of the Data menu, or click 
on this button located in the application toolbar, to open the definition window for the polygonal 
limits, as shown in figure 7-16.  
 

 

Figure 7-16 - Definition window for the polygonal limits 
 
When opened, the LIM form is in “Query mode”, visible by the title and blue background of the 
entry form.  The bottom table show the points of the limit. The user chooses the limit number 
and executes the query with the [F8] key or the button shown here from the entry form toolbar.  
The data associated to the limit are then displayed in the table and the fields. All records 
(borings, axes) located within this limit are returned by the query, except the borings with a zone 
number different than the zone of the reference site. If the zones are not specified, the 
application does not apply any restriction.  
 
The buttons Rectangle< and Polygon< are only active in the Site module.  They are used to 
define polygonal limits directly with the mouse.  See the user guide of the Site module for more 
details.  
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Limits can also be manually inserted. The user only needs the easting and northing coordinates 
of 2 opposite points of a rectangle to create a rectangular limit.  
 
The reference is selected from the list of all the sites in the database, and indicates the site to 
use as reference for the limit.  
 

3.5. Group of Records 

Select the Group of Records option of the Retrieval by… sub-menu of the Data menu or click 
on this button located in the application toolbar, to open the selection window by groups of 
records, as shown in figure 7-17.  
 

 

Figure 7-17 - Selection window by groups of borings 
 
When opened, the SEL form is in “Query mode”, visible by the title and blue background of the 
entry form.  The user clicks on one of the 4 tabs at the bottom of the form to indicate in which 
table the records are located (SEL_SITE for records of sites, SEL_AXIS for those of axes, 
SEL_BORING for those of borings, SEL_SAMPLE for those of samples, SEL_PIEZO for those 
of piezometers).  The user then chooses the selection number and executes the query.  The 
data associated to the selection are then displayed in the table and the description field.  
 
When a query was done in one of the graphic modules, the Add button becomes active.  By 
going to the desired panel, clicking on the Add button will insert all the records in memory, 
which you can then save with a selection number.   
 
The site and boring fields under the Reference label show the site and possibly the boring 
numbers of the record selected in the bottom table by clicking on the numbered button left of the 
row.  
 
The groups of borings are particularly useful for the display of CPTu data done close to a 
boring. The main boring would be the reference - to display its stratigraphy, samples, etc. - and 
the CPTu would also be in the group, to display their measured and/or calculated properties. 
 
The groups of records are also useful for the selection of samples from one of several borrow 
pits which have desired grain size properties. 
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4. RECORD 

The options of the Record sub-menu of the Data menu correspond to the  
buttons in the main page and the entry forms.  The menu is also available when a data entry 
form is opened.  The user can directly call the first or last record; he can go to the previous or 
next record or call a specific record number by entering it in the box that is displayed.  
 
 

5. DATA ENTRY FORMS 

In the Geotec modules, the most appropriate data entry forms are included as options in the 
Entry… sub-menu of the Data menu and as buttons in the application toolbar (see figure 7-18 
for the Lab module). Refer to the specific guides for the data entry forms and the applications.   

 

 
 

 

Figure 7-18 - Data menu: Entry (Lab module) and corresponding buttons 
 
 

6. OPEN TABLE 

The Open Table option of the Data menu or this button located in the application toolbar is 
used to open any table or view (query) from the database. The window shown in figure 7-19 is 
displayed. 
 
We can include in the scrolling list all the tables and/or all the views (queries) of the 
database, by checking the appropriate box at the bottom of the window.  The user can then 
choose the desired table or view in the list. 
 
The user also select the display format for the entry form to open.  The display formats can also 
be changed via the Display menu when the entry form is open. The formats are described in 
chapter 1 of the entry forms guide. By clicking on Open, the entry form is displayed.  
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Figure 7-19 - Open Table 
 
 

7. DATA SHEETS 

The Data Sheets option of the Data menu or this button and located in the application toolbar is 
used to open a data sheet on the table associated to the current graph.  The data sheets are 
used for visualisation.  No change made here is saved in the database.  
 
 

8. REPORT 

The Report option of the Data menu or this button located in the application toolbar is used to 
open the Configuration window for the forms and reports. The same button located in an 
entry form toolbar or the Report option of the Action menu will open the window with data for 
the current table.  
 
The configuration window is used to define the display parameters of an entry form as well as 
the data sheets. It is also used for the production of specific reports, external files presenting the 
data from the current table. The configuration window is presented in figure 7-20.  
 
When an entry form is opened for the first time (for example, the sample form), a record for the 
table is automatically created in REPORT with the table name (example: SAMPLE) and 
FORM_DEF as the layout name, as well as records in REPORT_COL displayed in the table at 
the bottom of the configuration window, which contain the default configurations for the fields of 
the defined table.  
 
When changes are done to the configuration, they are saved in these 2 formatting tables. Any 
field added to a table during updates will be added at the end of the fields already defined. 
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If the record is deleted or if the layout name is modified, another record with the FORM_DEF 
layout will be created. To reset the format of an entry form, the simplest is to delete its record in 
REPORT.  
 
If a customised format name other than Default is added in the preferences window (see 
chapter 6 of X3D), new records for the tables used will be automatically created and 
saved with the layout name FORM_DEF_name. 
 
A query can be done as in all the other entry forms to retrieve the configuration of a table from 
the scrolling list.  

 

 

Figure 7-20 - Configuration of the entry forms and reports 
 

8.1. Configuration via REPORT_COL 

The table at the bottom of the configuration window presents the parameters of the fields from 
the table defined at the top of the window.  When a user moves, hides (by dragging the field 
outside the form) or modifies the dimensions of the columns in the Datasheet (+) or Columnar 
(+) display formats or in the data sheets, the information is saved in REPORT_COL.  
 
The Reset button is used to reset the values of the current row in the REPORT_COL table. 
Several rows can be selected at the same time for resetting.   

• The CNAME column contains the field names. The values cannot be modified.  

• The COL_NO column contains the field number as defined in the database, the first field 
defined being #0.  The values cannot be modified.  

• The DATATYPE column indicates the field type, as defined in the database.  The values 
cannot be modified.  
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• The LENGTH column indicates the field length in characters. The values cannot be 
modified.  

• The RANK column defines the order in which the columns or rows (in Columnar(+) format) 
are displayed from left to right or top to bottom, the value “1” defining the column at the far 
left or top.   The values cannot be modified in the configuration window. 

The rank values are modified when the user moves the columns in the various display 
formats of the table or in the data sheets.  

• The SORT_ORDER column is used to define the sorting priority for each column for the 
data presentation.  A position order number means an increasing order; a negative order 
number means a decreasing order.  The “0” order number keeps the sort order already 
defined. The sorting will first be done on the values of the field with “1” or “-1“ as sort order, 
then on the values from the field with “2” or “-2”, etc. By default, the data are presented in 
the order returned by the query.   

Changing the value of a SORT_ORDER cell affects the value of one or many other 
SORT_ORDER cells.  

• The cells of the FREEZE column contain “No” by default.  A “Yes” in a cell of the FREEZE 
column means that the eventual horizontal scrolling bar of the table of data sheet will affect 
only the columns right of the one to which the cell belongs.  Only one cell of the FREEZE 
column can contain “Yes”. This option works only for the fields located in the left third of the 
table.   

• The PROTECT column indicates the protection against editing.  By default, the protection is 
at “None”.  By double-clicking in the cell, Partial is indicated, meaning that the user can only 
select values in a scrolling list. By double-clicking again, Total is indicated - the field will be 
disabled.  

• The HIDE column is used to define if the field will be visible or not in the table or data sheet.  
By default, the value is "No". To change the value, double-click in the cell. When the entry 
forms are in Table or Table+ format, the user can also hide fields by dragging the column 
header outside the entry form. 

• The WIDTH field expresses in number of characters the widths of the columns of the table 
or data sheet.  By default, the widths are equal to 1 more than the lengths of the fields, with 
a minimum of 5 and maximum of 20.  The user can change these widths. They are also 
modified when the user adjusts the width of the columns with the mouse in the tables or data 
sheets.  

• The LINE_FEED column is used to indicate with Yes or No if the values represented in the 
column will be displayed on several lines with a word wrap when the value is not displayed 
entirely in the cell. 

• The FORMAT column is used to enter the format with which the data should be displayed.  
If the format is not appropriate for the data type, the values will not be displayed, or will be 
displayed with a default format.  Two types of format can be used:  

 A C expression (“%g”, “%.2f”, “%.0e”, “%s” for example); 

 A mask, for example: “999.99” for have a number with two decimals, “9.99e” for a 
number in scientific notation, “text” for the value to be considered as a character string 
even if it is a number, “yyyy-mm-dd hh:mi” for a date.  
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• The NULL_VALUE column is used to enter a character string, of 50 characters maximum, 
to be displayed instead of values missing from the column in the table or data sheet.  

• The TITLE column is used to enter the strings desired as the columns (fields) titles. By 
default, the field name is entered.  

• The DESCRIPTION column shows the tooltip message defined in the data dictionary. The 
values can be modified by the user. According to the option selected in the preferences 
window (see chapter 6 of this guide), it is either the description defined in this field or the 
description provided by the software in the language used that will be displayed in the 
tooltips. 

• The LIST is used to indicate with Yes or No if the list of distinct values from the database is 
shown (yes) or hidden (no). By default, the value is Yes. 
 

8.2. Report parameters 

The section in the middle of the configuration window is used to define a specific report to be 
produced. The columns of the report are the one of the configuration used.  

• The type of report is selected from the scrolling list that has 5 choices: Block, Tabular, 
Personal, CSV file and Export.  According to the type of report selected, there are more or 
fewer parameters that have a role and for which the user can intervene. 

• The output file extension may be defined or not by the user, depending on the report type.  
The value is either imposed or proposed by default.  

• The title of the report can be edited for the Personal type reports. The title is only shown in 
the report if the box left of the title field is checked.  

• The table heading can be edited for the Personal type reports.  In the other cases, a value 
indicating the table name is either imposed, or the field is not used. 

• The user can choose as headings of the report columns the field names or the titles defined 
in the configuration table, by clicking on Name or Title, respectively, in the scrolling list.  

• The Underline field is used to define with which character the columns headings will be 
underlined in the report.  

• The Separator field is used to indicate with which characters the columns of the report will 
be separated.  

• The Empty field replacement field is used to enter a string of up to 50 characters, to fill the 
fields without value in the report.  The string entered in this parameter does not have priority 
on the string entered for a field in the NULL_VALUE cell of the configuration window. 
 

 

9. EXPORTING A REPORT 

To produce a CSV report with the data retrieved, click on the Export button in the entry form 
toolbar or on the Export option of the Action menu.  The file saving window opens on the 
directory of the output files. The current configuration format defined in the preferences, either 
FORM_DEF if it is default, or FORM_DEF_name if another name is defined, will be used for the 
report. See chapter 6 of X3D. 
 
The Export option is also available directly in the report window (see paragraph 8) to produce 
specific reports. 
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10. IMPORTING EXTERNAL DATA 

The option Import File of the Data menu or this button located in the application toolbar opens 
the window to Import External Data. The same button located in an entry form toolbar or the 
Import File option of the Action menu will open the window to import in the current table. 
 

10.1. Import window 

The import window is used to import .csv files or application files specific to some tables.  
 
The first field Table name is inactive if the import window was opened directly from an entry 
form. If it is opened from the application toolbar, the user will need to select the table in which to 
import from the scrolling list showing all the tables of the database. 
 
The separator can be selected by the user, but is adjusted automatically when reading the file, 
unless two types of separators are found.  
 
10.1.1. Selection and display options 

10.1.1.1. Select a file 

By clicking on Select and read a file, the Windows selection window opens on the last import 
directory used. After selecting a file, the data are automatically read and displayed in the table 
of the tab labelled Data from current file, as well as the file name and total number of records 
read. The file path is also written in the Path field. See Figure 7-21.  
 
10.1.1.2. Select a directory 

By clicking on Select a directory, the Windows selection window opens on the last import 
directory used. After selecting a directory, the list of all .csv files of the directory is displayed in 
the table of the tab labelled List of files, as shown in Figure 7-22. The path is also writte in the 
Path field.  
 
10.1.1.3. Application file 

For the CPTU and axis entry forms, it is possible to insert an application file with a specific 
structure. This option will then be active. 
 
For the CPTU entry form, if the box Application file is checked, the file extension is modified 
for “.drf”, the box “Insert parent records” is automatically checked and the replacement option 
“Insert new records only” is selected. See chapter 4 of the Geo guide for all details about the 
import of .drf files. 
 
For the axes entry form, if the box Application file is checked, the file extension is modified for 
“.prf” (seismic profiles file), the box “Insert parent records” is automatically checked and the 
replacement option “Insert new records only” is selected. The .prf files have a specific 
formatting. They are used to insert profiles of stratigraphic layers along an axis and the 
measured seismic velocities. Please contact us if you need to exact format. 
 
10.1.1.4. List of directories 

The Path field gives the list of the last 9 directories used. 
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Figure 7-21 - Importing external data – Data from current file 
 
10.1.2. Insertion and replacement options 

10.1.2.1. Insert parent records 

When the option Insert parent records is checked, the software will verify if the parent records 
of the data to insert already exist in the database. If yes, the insertion of the parent record will 
be omitted. If not, parent records with only the assigned numbers will also be created at the 
import. For example, if a .csv file of samples is inserted by the site and borings of the samples 
do not exist, they will also be created. 
 
If the option is not checked and the parent records do not exist, the new data will not be saved. 
An error message indicating why will be created in the report and the user will need to manually 
insert the parent records before trying to reimport the data.  
 
10.1.2.2. Insert new records 

The option Insert new records is always selected. It indicates that all records whose keys do 
not exist in the database will be inserted.  
 
Example: if a file contains information of 10 borings, 5 of which are already defined in the DB, 
only the other 5 will be inserted.  
 
10.1.2.3. Update missing values 

If the option Update missing values is selected, then when records are already present in the 
DB and some fields defined with a value in the .csv file are empty in the database, these data 
will be inserted when importing. The other data already in the database will not be affected. 
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Example: if a file contains the X and Y coordinates of borings that are already inserted in the 
database but whose fields EASTING and NORTHING are empty, these coordinates will be 
inserted.  
 
10.1.2.4. Update all different values 

If the option Update all different values is selected, then all the values of the .csv file that are 
different than the existing values in the database will be inserted and will replace the existing 
values. Note: if cells are empty in the .csv file, they will not affect existing values in the DB.  
 
It is possible to delete values from the DB. To do this, write NULL or ! as value in the desired 
cells of the .csv file.  
 
10.1.3. Read and save in database 

After selecting a file, the data are automatically read and displayed in the table of the tab Data 
from current file, as shown in Figure 7-21. 
 
After selecting a directory, the list of files is automatically displayed in the table of the tab List of 
files, as shown in Figure 7-22. 
 

 

Figure 7-22 - Importing external data – List of files 
 
By clicking on the Read button, all checked files are read and the total number of records read 
is indicated in blue, as well as in the Read column for each file. It is possible to uncheck files by 
clicking in the cell in the column left of the file name.  
 
By selecting the row corresponding to a file (by clicking in the # column), we can click on the tab 
Data from current file to read and see the data from the selected file. 
 
After selecting a file or directory, the user clicks on Save to save in the database. The total 
number of new records inserted will be displayed in blue, as well as in the Inserted column for 
each file. When the options to update missing values and / or different values are selected, the 
number of modified records for each file is indicated, as well as the number of updated values. 
 
A transaction file is created for all operations every day. By clicking on Report, this file is 
opened with the text editor selected in the preferences window (see chapter 6 of this guide). 
The transaction file is saved in the directory of output files (see chapter 6 of this guide). This 
Report indicates the name of each file read and its directory, the number of records read, 
existing and inserted, the number of records and fields updated if applicable, as well as the 
tables involved. 
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10.2. Format of the .csv data files 

The standard .csv files must have a row containing the field names to insert, which must 
correspond to the fields names as defined in the database. To obtain the field names, place the 
cursor of the mouse inside the field and press the F1 key; a tooltip appears showing the field 
name, among other properties. 
 
All values follow. When the program reads the .csv file, it verifies if the field names exist in the 
selected table and then reads all these values. If a field name is not found for the selected table, 
the column will be ignored. 
 
The standard .csv files must contain the primary keys; otherwise it is impossible to know where 
to insert the data.  
 
To delete data from the database, for example to delete all values of GROUND_ELEV for the 7 
borings of table 7-1, enter ! or NULL and select the option “update all values”.  
 

Table 7-1 - Example of .csv to insert into the BORING table 

SITE_NO BORING_NO EASTING NORTHING GROUND_ELEV 

PETITE-DIGUE TF-01 300000 5000000 ! 

PETITE-DIGUE TF-02 300010 5000010 ! 

PETITE-DIGUE TF-03 300020 5000020 ! 

SMALL-DAM TP-01 300030 5000030 ! 

SMALL-DAM TP-02 300040 5000040 ! 

SMALL-DAM TP-03 300050 5000050 ! 

SMALL-DAM TP-04 300060 5000060 ! 
 

Table 7-2 - Example of .csv to insert into the GRAIN_SIZE_POINT table 

SITE_NO BORING_NO SAMPLE_NO SIZE PASSING 

PETITE-DIGUE PU-01 1 80 100 

PETITE-DIGUE PU-01 1 56 90 

PETITE-DIGUE PU-01 1 40 88.9 

PETITE-DIGUE PU-01 1 31.5 80 

PETITE-DIGUE PU-01 1 20 71 

PETITE-DIGUE PU-01 1 10 55 

PETITE-DIGUE PU-01 1 5 41.55 

PETITE-DIGUE PU-01 1 0.08 24.5 

PETITE-DIGUE PU-01 1 0.0351 13 

PETITE-DIGUE PU-01 2 80 98 

PETITE-DIGUE PU-01 2 56 87 

PETITE-DIGUE PU-01 2 40 68 

PETITE-DIGUE PU-01 2 31.5 51 

PETITE-DIGUE PU-01 2 20 41 

PETITE-DIGUE PU-01 2 10 27 

PETITE-DIGUE PU-01 2 5 25 

PETITE-DIGUE PU-01 2 0.08 8 
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CHAPTER 8. WINDOW AND HELP MENUS 

1. WINDOW MENU 

In addition to the standard “Tile”, “Cascade” and “Arrange Icons” options, each option of the 
Window menu represents an open window in the application.  The option that represents the 
active window is indicated by a check mark.  If the user clicks on one option of this menu, the 
corresponding window becomes active. 
 
 

2. HELP MENU 

“Keyboard Shortcuts” opens a window with the description of the keyboard shortcuts that can 
be used in the entry forms for various types of functions: Action, Query, Record, Field, Table 
and Help. 
 
“About” gives information about the versions used by the application, the PIN and type of 
licence, as well as the expiration date of the licence or the maturity date of the annual support 
and maintenance contract.  
 
 “Contents” and “Search for help on…” are not active.   
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CHAPTER 9. DRAWING ATTRIBUTES 

1. INTRODUCTION 

When an application using X3D is first used, some graphic entities may already exist, such as 
graphs and objects. Each entity is displayed with specific drawing attributes, like the line 
thickness and the background color.  Also, minimal drawing attributes are defined by default for 
the graphic entities that will be created.  These basic default attributes are:  

• Texts in black with 2.82 mm characters (size 8) using the normal Arial font; 

• Solid black lines of 0.1 mm thickness; 

• No filling, no marker and no pattern. 
 
These attributes will remain the default attributes as long as they are not modified.  The default 
attributes established when the application is closed are saved in the work environment of the 
application for the next use.  
 
To modify the default drawing attributes, open the preferences editing window and click on the 
button under the Drawing attributes label in the Default panel (see chapter 6).  Modifying the 
default drawing attributes does not change the drawing attributes of the entities, graphs or 
objects already defined in the page.   
 
Clicking on the Default button in this window will replace the default attributes with the basic 
minimal values defined above.  
 
In most graphic entities configuration windows, there is at least one button used to display the 
drawing attributes editing window, shown in figure 9-1.  Several elements can be modified, like: 

• in the graph editing window, the background, border and title of the current graph; 

• in the axes editing window, the axis line of the selected graph (with the button under “Axis 
line”) and the title of this axis (with the button under “Title”).  

 
The default attributes defined in the preferences editing window can be used by clicking on the 
Default button in their attributes window.  
 
The Drawing Attributes option of the Insert menu or this button, located in the graphic editing 
toolbar when the application is in graphic editing mode, opens the Attributes window.  The 
attributes defined in the Attributes window will be those of the future objects created.  
 
In graphic editing mode, the attributes of a selected object can be modified by clicking on the 
button shown here above, or via its property window opened by double-clicking on the object or 
with the Properties option of the pop-up menu displayed with a right-click.  
 
Clicking on the Default button of the Attributes window opened for objects gives these objects 
the default attributes defined in the preferences editing window.  
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Figure 9-1 - Drawing attributes configuration window 
 
In the attributes window, it is possible to modify, as applicable, the following components:  

• the text (XVT) 

• the line (XVT) 

• the filling (XVT) 

• the marker (X3D) 

• the pattern (X3D) 
 
These components are represented at the bottom of the window by large buttons displayed 
under their title. The series of color buttons under the preview area is used to define the color of 
the selected component.  
 
The attributes of some components, particularly the text, can be detailed by a series of other 
specific controls.  
 
The preview area, with its polygon, polyline and text, displays the configuration of the current 
attributes.  Double-clicking in the preview area opens the XVT window for the configuration of 
attributes, as shown in figure 9-2. 
 
This configuration window displays all the panels that can be opened to edit the XVT text, line or 
filling. The Reset button sets everything back to the values selected when the window was 
opened. 
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Figure 9-2 - XVT window for the configuration of attributes 
 
 

2. SELECTING A COMPONENT 

A graphic entity, a curve, axis, superimposed object to a graph, etc., can include one, many or 
all of the components. 
 
To assign a color or style to a component, it must be selected. Click on the button of a 
component to select it; it then appears pushed in.   
 
If the component’s button is selected, click on a color button under the preview area to change 
the component’s color.  Clicking on the “-” button hides the component, without deleting the 
object containing it.  Clicking on the “+” button opens the color personalization window (see 
paragraph 8). 
 
Double-clicking on a component’s button: 

• opens the configuration window specific to the selected component in the case of an XVT 
component; 

• opens the marker or pattern selection window, depending on the component selected, in the 
case of an X3D component.  

 
A component remains selected until another is selected. It is not necessary to select a 
component to modify an attribute other than the color, XVT style, or X3D marker or pattern 
choice.  For example, changing the height of characters will have an effect even if the Text 
component is not selected. 
 
When a component is selected, its color’s number is shown in the Color field of the attributes 
window (see figure 9-1). If a marker or a pattern is selected, when the corresponding button is 
clicked, the number of the marker or pattern is written in the Number field.  
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3. XVT TEXT EDITING 

Double-clicking on the Text button opens the XVT window illustrated in figure 9-3. 
 

 

Figure 9-3 - XVT window for text configuration 
 
The Color panel is used to define the text color in the Foreground section and the background 
color of the text in the Background section.  Clicking on More allows the user to select a 
customized color (see paragraph 8). 
 
In order for the text background color to be visible, open the Advanced panel and check the 
Opaque text background? box.  The Opaque checkbox of the Attributes window has the 
same role.  In the Advanced panel, the Drawing mode field has no role. 
 

 

Figure 9-4 - Font definition window 
 
In the Attributes window, the Height field defines the exact height for the characters; in 
millimeters.  With the font selection done by clicking on the Font button, the user can choose a 
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size, in points.  This selection modifies the value in millimeters in the Height field and in points 
in the Size field. Figure 9-4 illustrates the text font definition window. 
 
In this window, the user can change the font, style and size of the text. The user can select the 
Strikeout and Underline boxes below the Effects label.  The user can also select the type of 
characters desired in the list associated to the Script field. The result appears below the word 
Sample. 
 
The name of the font can be entered directly in the Attributes window under the Font button. 
The user can directly select the Bold, Italic and Underline styles and define the height of the 
characters in the Size field.  
 
The angle of the text is indicated in degrees with respect to the horizontal, in the counter 
clockwise direction.  By default, the text is horizontal; its angle is 0.  Figure 9-5 shows different 
text angles.  

 

Figure 9-5 - Text angle 
 
The Line Spacing of the text is expressed in character height. The text lines will be:  

• superimposed with a line spacing of 0; 

• without a space between them with a line spacing of 1; 

• with a space of one character’s height, with a line spacing of 2, etc. 
 
Below the Offset title, two fields define how the text will be shifted compared to its anchor point. 
For the offset in X, a positive value is towards the right. For the offset in Y, a positive value is 
towards the top.  
 
The Alignment button positions the text with respect to its anchor point.  The nine white 
rectangles of the Alignment button symbolize the nine possible positions of the anchor point 
compared to the rectangle containing the text.  Click on one of these boxes to select it.  Click it 
again to unselect it. 
 
The Format field is used to indicate the format of the elements whose attributes are getting 
modified. Two display format options are permitted: 

• a C expression (“%g”, “%.2f”, “%.0e”, “%s” for example); 

• a mask, for example: “999.99” to have a number with two decimals, “9.99e” for a number in 
scientific notation, “text” for the value to be considered as a chain of characters even if it is a 
number, “mm-dd-yyyy hh:mi” for a date.  
 
A scrolling list is associated to the format field, as shown in figure 9-6.  The user is not 
limited to these masks, but can use them to initiate others.  
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Figure 9-6 - Scrolling list of typical formats 
 
The Text button with the Abc label shows the font, style and color of the text.  The word “Text” 
in the preview area shows the font, style, color, size, style, alignment, angle and offset of the 
text.  
 
 

4. XVT LINE EDITING 

Double-clicking on the Line button opens the XVT window illustrated in figure 9-7. 
 

 

Figure 9-7 - XVT window for line configuration 
 
In this window, the user can define the line color.  Clicking on More allows the user to select a 
customized color (see paragraph 8).  The user can also select the line style by selecting one of 
the three radio buttons under Style: Dash, Dot or Solid (full line). Lastly, the user can define 
the width of the line.  It is expressed in tenths of a millimeter. The Width field also appears in 
the Attributes window directly under the Line button. The radio buttons of the Pattern section 
have no role.   
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In the Attributes window, the frame and line under the Line button and the polygon and 
polyline in the preview area have the color, style and width of the line.  
 
Depending on the screen definition, it is possible that the chosen color cannot be 
displayed.  The closest basic color is then used.  Also, the resolution of the screen will 
affect the line style according to the selected thickness; increasing the width of a line will 
eventually result in a dashed or dotted line appearing as solid.  
 
For the printouts, the result depends on the selected pilot and on the configuration of printing 
properties.  To obtain dotted or dashed lines when printing, the width indicated in the attributes 
window must be 0 mm. 
 
 

5. XVT FILLING EDITING 

The Filling button allows the user to choose a filling background for any closed area (rectangles 
of a graph, legend, histogram, object of polygonal form, etc.).  Applying a filling to an open area 
has no effect.  
 
If a closed area is filled, everything displayed underneath is hidden.  Having hidden or visible 
elements in a filling area depends on the display sequence of the different components.  This 
sequence is usually imposed by X3D or the application but can sometimes be controlled by the 
user.  For example, in the case of superimposed graphs, the user can decide the order in which 
they will be displayed, using their number.  
 
The user can display an X3D pattern over the filled area (see paragraph 7). 
 
Please note, if the Black and white option of the page editing window is selected (see chapter 
6), the filling colors are not displayed; however, the filing pattern and the hidden elements 
remain in effect. 
 
Double-clicking on the Filling button opens the XVT window illustrated in figure 9-8. 
 
The Brush panel is used to define the filling color.  Clicking on More allows the user to select a 
customized color (see paragraph 8).  In the Pattern section, the user selects the XVT filling 
pattern.  The top left box sets an “empty” pattern; no filling is displayed. The second top left box 
sets a solid pattern.  The other boxes set patterns with hatchings or squares.  
 
The Color panel is used to define the background color of the filling.  This color is visible only if 
the pattern selected is striated.  There is always a background color (white by default).  
 
The filling color, its pattern and the background color are shown in the Filling button and fill the 
polygon in the preview area of the Attributes window. 
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Figure 9-8 - XVT window for filling configuration 
 
The XVT fillings are “computerized” patterns.  Consequently, the result can vary from one 
printer to another.  To ensure to always obtain the same pattern, we recommend the use of the 
X3D patterns (see paragraph 7). 
 
If texts disappear under a filling zone during printing, it is probably due to a bad configuration of 
the printer.  For example, with an "HP LaserJet" printer in mode “vectorial graphs”, the 
overlaying is incorrect and the user must select the mode “graphs in dot mode” (also known as 
“screened graphs”).  
 
 

6. SELECTION AND PRESENTATION OF A MARKER 

The button of the Marker component is used to select a marker that will be applied to the 
summits of the polylines and the line extremities. Double-click on the Marker button to open the 
marker selection window. An example is shown in figure 9-9.  
 
The palette displayed includes the markers defined in the current .mrk markers file, whose path 
is shown in the window title.  The markers file can be selected from the Recent Markers option 
of the File menu or from the marker editor (see chapter 6).  To select a marker, click on it in the 

palette and close the palette with the  button. 
 
Once the marker is selected, it is possible to assign a new color to it by clicking on one of the 
color buttons under the preview area of the Attributes window.  A multi-colored marker 
becomes single-colored.  Even if a new color is assigned to the selected marker, it will not be 
modified in the markers file.  To modify a marker and keep the changes, it must be edited (see 
chapter 6). 
 
The marker selection button is accompanied by these fields: 

• Period: to define the frequency of the markers; a period of 0 shows no marker; a period of 1 
shows a marker at each point; a period of 2 shows a marker at every two points, etc.;  

• Diameter: to enter the size of the marker in millimeters; 
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• Angle: to define the display angle of the markers with respect to the vertical; the rotation is 
measured in the counter clockwise direction with a positive angle value.  

 

 

Figure 9-9 - Marker selection window 
 
The selected marker is shown in the Marker button and at the summits of the polyline in the 
preview area of the Attributes window. Its number is indicated in the Number field if the Marker 
button is selected. 
 
 

7. SELECTION AND PRESENTATION OF A PATTERN 

The Pattern button allows the user to choose an X3D pattern that will be applied to closed 
areas.  Double-click on the Pattern button to open the pattern selection window. An example is 
shown in figure 9-10.  
 
The palette displayed includes the patterns defined in the current .ptn patterns file, whose path 
is shown in the window title.  The patterns file can be selected from the Recent Patterns option 
of the File menu or from the pattern editor (see chapter 6).  To select a pattern, click on it in the 

palette and close the palette with the  button. 
 
Once the pattern is selected, it is possible to assign a new color to it by clicking on one of the 
color buttons under the preview area of the Attributes window.  Even if a new color is assigned 
to the selected pattern, it will not be modified in the patterns file.  To modify a pattern and keep 
the changes, it must be edited (see chapter 6). 
 
The selected pattern is shown in the Pattern button and fills the polygon in the preview area of 
the Attributes window. Its number is indicated in the Number field if the Pattern button is 
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selected. It is possible to choose a filling with an XVT pattern and to display an X3D pattern on 
top.  
 

 

Figure 9-10 - Pattern selection window 
 
 

8. PERSONALIZATION OF COLORS 

By selecting the More box in the XVT windows for the configuration of attributes or by clicking 
on the “+” button in the Attributes window, the user can customize the color to apply.  These 
selections open the color editing window. 
 
To define a new color, place the cursor in the matrix or directly provide the values of hue, 
saturation, luminosity, red, green and blue. The Color|Solid box is filled by the defined color. By 
clicking on OK, the selected color becomes the color of the current attribute and its 
corresponding number is indicated in the Color field of the attributes window.  Currently, the 
addition of custom colors is not implemented.  
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